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About the
Documentation

This manual is part of a set of Fiery EX2101 for Xerox 2101™ documentation that
includes the following manuals for users and system administrators:

* The Quick Start Guide summarizes the steps for configuring the Fiery EX2101 for
Xerox 2101 and printing. It also describes how to access the Adobe Acrobat PDF
files on the User Documentation CD.

* The User Software Installation Guide describes how to install software from the
User Software CD to enable users to print to the Fiery EX2101 for Xerox 2101, and
also describes setting up printing connections to the Fiery EX2101 for Xerox 2101.

* The Configuration Guide explains basic configuration and administration of
the Fiery EX2101 for Xerox 2101 for the supported platforms and network
environments. It also includes guidelines for setting up UNIX, Windows
NT 4.0/2000/2003, and Novell NetWare servers to provide printing services

to users.

* The Printing Guide describes the printing features of the Fiery EX2101 for Xerox
2101 for users who send jobs from their computers.

* The Job Management Guide explains the functions of the job management utilities,
including Command WorkStation™, Command WorkStation LE™, and DocBuilder
Pro™, and how you can use them to monitor and control jobs on the Fiery EX2101
for Xerox 2101. This manual is intended for an operator or administrator, or a user
with the necessary access privileges, who monitors and manages job flow and
troubleshoots problems that may arise.

* Customer Release Notes provide last-minute product information and workarounds
for some of the problems you may encounter.
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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void
the user’s authority to operate this equipment.

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the
approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice
This Class B digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe B de I'Industrie Canada

Cet appareil numérique de la Classe B est conforme a la norme NMB-003 du Canada.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user
who is responsible for compliance of his particular installation.

Dieses Gerit wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstérbestimmungen
gepriift. Es ist jedoch méglich, dass die Funkentstérbestimmungen unter ungiinstigen Umstinden bei anderen Geritekombinationen nicht eingehalten werden.
Fiir die Einhaltung der Funkentstérbestimmungen einer gesamten Anlage, in der dieses Gerit betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hiingt davon ab, dass geschirmte Ausfithrungen beniitzt werden. Fiir die Beschaffung richtiger Ausfithrungen ist der
Betreiber verantwortlich.

Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE.



License

EFI grants you a non-exclusive license to use the Software and accompanying documentation (“Documentation”) included with the Product. The Software is
licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend the Software
or use the Software in any time sharing, service bureau, or similar arrangement.

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) copy for backup or archive purposes in
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to localize, translate, disassemble,
decompile, decrypt, reverse engineer, discover the source code of, modify, create derivative works of, or in any way change any part of the Software.

The terms, conditions, and restrictions in the License Agreement apply to all bug fixes, patches, releases, release notes, updates, and upgrades related to the
Software.

Proprietary Rights

You acknowledge and agree that all rights, title and interest, including all intellectual property rights, in and relating to the Software, Documentation and all
modifications and derivative works thereof are solely owned by and shall remain with EFI and its suppliers. Except for the express limited license granted above
to use the Software, no right or license of any kind is granted. You receive no rights or license under any patents, copyrights, trade secrets, or trademarks (whether
registered or unregistered). You agree not to adopt, register, or attempt to register any EFI trademark or trade name (“EFI Mark”) or any confusingly similar mark,
URL, internet domain name, or symbol as your own name or the name of your affiliates or products, and not to take any other action which impairs or reduces
the trademark rights of EFI or its suppliers.

Confidentiality

The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may, however, permanently transfer all of
your rights under this Agreement to another person or legal entity provided that: (1) such a transfer is authorized under all applicable export laws and regulations,
including the U.S. Export Administration Regulations, (2) you transfer to the person or entity all of the Software and Documentation (including all copies,
updates, upgrades, prior versions, component parts, the media and printed materials, and this Agreement); (3) you retain no copies of the Software and
Documentation, including copies stored on a computer; and (4) the recipient agrees to the terms and conditions of this Agreement.

Remedies and Termination

Unauthorized use, copying, or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make
available to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software, Documentation, and all component parts thereof.
All provisions of this Agreement relating to disclaimers of warranties, limitation of liability, remedies, damages, governing law, jurisdiction, venue, and EFI’s
proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements,
that the operation of the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no
warranty, implied or otherwise, regarding the performance or reliability of any third party products (software or hardware. THE INSTALLATION OF ANY
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION,
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD
PARTY RIGHTS.



Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this agreement to the extent that this agreement contains provisions which relate to your use of any software, font programs, typefaces, and/or
trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE
WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Export Controls

EFI’s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as foreign export laws and regulations.
You agree that you will not use, distribute, transfer, export, or re-export any portion of the Product or the Software in any form in violation of any applicable laws
or regulations of the United States or the country in which you obtained them.

U.S. Government Restricted Rights:

Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 12.212 or DFARS 227.7202-3 -
227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as set out in FAR 52.227-14, Restricted Rights Notice (June 1987)
Alternate ITI(g) (3) (June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the Agreement, such data is protected per
FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS 252.227.7015
(November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced agency regulations are modified or superceded, the
subsequent or equivalent regulation shall apply. The name of the Contractor is Electronics for Imaging.

General

The rights and obligations of the parties related to this Agreement will be governed in all respects by the laws of the State of California exclusively, as such laws
apply to contracts between California residents performed entirely within California. The United Nations Convention on Contracts for the International Sale of
Goods and any other similar convention does not apply to this Agreement. For all disputes related to this Agreement, you consent to the personal and exclusive
jurisdiction and venue of the state courts in San Mateo County, California and the federal court for the Northern District of California. This Agreement is the
entire agreement held between us and supersedes any other communications or advertising with respect to the Software. If any provision of this Agreement is held
invalid, such provision shall be deemed modified to the extent necessary to be enforceable and the other provisions in this Agreement shall continue in full force
and effect.

If you have any questions, please see EFI’s web site at www.efi.com.
Electronics for Imaging

303 Velocity Way
Foster City, CA 94404
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xiii | About this manual

Introduction This manual is intended for Fiery EX2101 for Xerox 2101 operators and
administrators, or users with the necessary access privileges, who monitor
and manage job flow, manipulate jobs, and troubleshoot problems that may arise.
It describes the functions and features of the Fiery® job management utilities—
Command WorkStation, Command WorkStation LE, Fiery Spooler™, and Fiery
WebSpooler™—for the purposes of job management and quality control.

NoTE: In this guide, the term “Fiery EX2101” is used to refer to the Fiery EX2101 for
Xerox 2101. The name “Aero” is used in illustrations to represent the Fiery EX2101.
The term “copier” is used to refer to the Xerox 2101 copier. The term “Windows” is
used to refer to Windows 98, Windows Me, Windows NT 4.0, Windows 2000,
Windows XP, and Windows Server 2003, wherever appropriate. Illustrations of
Windows software may not necessarily reflect the version of Windows that you use.

About this manual

This manual is organized as follows:

¢ Chapter 1 provides preliminary background information about job management
and introduces the Fiery job management utilities. It explains how to set up an
operator-controlled print environment and discusses job workflows that commonly
occur on the Fiery EX2101.

* Chapter 2 introduces the Command WorkStation and Command WorkStation LE
user interfaces. It also provides information on basic Command WorkStation and
Command WorkStation LE functions, such as printing Fiery EX2101 information
pages and setting preferences.

* Chapter 3 provides instructions on how to monitor and manage job flow using
Command WorkStation and Command WorkStation LE. It explains how to hold,
process, print, and cancel selected jobs, and how to track and archive printed jobs.

* Chapter 4 describes how to preview, edit, and merge jobs using the Preview windows
of Command WorkStation and Command WorkStation LE.

¢ Chapter 5 describes how to use the Imposition feature of DocBuilder Pro to arrange
the pages of your print job in special layouts for folding, binding, or cutting after
printing. The Imposition feature is available only if you have installed the
DocBuilder Pro option for Command WorkStation.
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* Chapter 6 provides instructions on using advanced aspects of DocBuilder Pro to
create custom layouts and take full advantage of Imposition features.

¢ Chapter 7 describes Fiery WebSpooler and Fiery Spooler, which you can use to view
and manage Fiery EX2101 job activity.

* Chapter 8 describes FieryBar. It explains the various messages and icons you might
see and also explains how to start up and shut down the Fiery EX2101 if you have
the Fiery Advanced Controller Interface (FACI) installed.

* Appendix A provides an overview of the terms and concepts of imposition,
including various folding, binding, and cutting methods.

* Appendix B describes the built-in templates available from the Imposition feature of
DocBuilder Pro.

* Appendix C provides basic troubleshooting information.

Terminology

Specific terms are explained as they are introduced. However, the following general
terms are used throughout:

* PostScript (PS)—A computer language designed as a page description language.
The Fiery EX2101 uses this language to image the page and communicate with
applications and the copier.

The term “PostScript” can also be used to refer to PDF data jobs. PDF is a
structured form of PostScript that provides the ability to preview, scale, and reorder
pages. Where applicable, the term “PDF” is specifically used to refer to PDF data

or jobs.

* Printer Control Language (PCL)—A computer language designed as a page
description language. The Fiery EX2101 uses this language to image the page, and
communicate with applications and the copier.

* Job—A file consisting of PostScript or PCL commands and comments that describe
the graphics, sampled images, and text that should appear on each page of a
document, and the printer options that should be used in printing, such as media or
finishing options.
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* Spool—Write to a disk. Used in this manual to refer to a PostScript or PCL
print job saved to the Fiery EX2101 hard disk drive in preparation for processing
and printing.

* RIP—Acronym for raster image processing, which changes PostScript or PCL

commands into descriptions of each mark on a page. In common use as a noun, a
raster image processor” (RIP) is the computer processor that performs this function.

The Fiery EX2101 RIP changes text and graphics commands in PostScript or PCL

into specifications for each dot of toner deposited on a page by the copier.

* Process—The term “process” is used interchangeably with the term “RIP” in this
manual to refer to raster image processing.

* Print—The task of rendering, or imaging, a page or job on a print device.

These concepts explain how the Fiery EX2101 and the copier work together as a
powerful printing system.






Chapter 1:
About Job
Management

1-1 | Job environments

This chapter explains the basic principles of job management in an operator-controlled
print environment and provides an overview of the Fiery EX2101 job management
utilities.

Job environments

The Fiery EX2101 supports several control levels of printing, job management, and
Setup, and gives you the flexibility to choose a configuration that corresponds to the
requirements of your site.

Levels of job control

The following descriptions outline the range of levels of job control that may exist in
your environment:

* At one extreme, an operator in a high-volume printing environment controls the
entire job flow and all printing. Print jobs arriving from remote users are spooled to
the Fiery EX2101 hard disk drive and stored until the operator decides it is time to
print them. Additional functions (job overrides, prioritizing, and font management)
are reserved for the operator.

* At the other extreme, anyone on the local network can control all printing and
Fiery EX2101 functions. Operator intervention is not required. Users can print
from their workstations to any of the published print connections. Anyone can use
the job management utilities to control any print job.

You can implement intermediate levels of job control in your environment. However,

the job management utilities are best suited for an operator-controlled environment.
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Setting up an operator-controlled environment

This manual assumes you are working in an operator-controlled environment with
responsibility for managing job flow. To establish an operator-controlled environment,
you or the administrator must complete the following tasks:

Set up password privileges—The administrator must set up separate passwords for
operator access and administrator access to the Fiery EX2101. For instructions on
setting up passwords, see the Configuration Guide.

Publish the Hold queue only—The administrator must enable only the Hold queue,
not the Direct connection or the Print queue, in Setup. (For more information, see the
Configuration Guide.) This ensures that all jobs sent by remote users are spooled and
held on the Fiery EX2101, in preparation for job management by the operator.

Establish communication between users and the operator—The operator and remote
users must agree on a method for communicating print needs, such as FreeForm™
masters. Users can attach instructions to jobs using print option and notes fields

(see page 1-5).

Understanding job flow

In an operator-controlled printing environment, remote users send jobs to the Hold
queue of the Fiery EX2101. Using a job management utility, the operator views the list
of held jobs and decides when to release each job for processing and printing.

The operator may also intervene during the workflow, stopping jobs as they are
processed or printed, placing jobs on hold for future action, or overriding the
user-defined print settings for a job. In some cases, the operator may even modify a
job, duplicating or removing pages, or merging it with pages from another job before
releasing it for printing.
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Spooling

\

Processing

y

Printing

Spooling, processing, and printing

To understand job flow through the Fiery EX2101, it is helpful to consider the three
main stages of printing.

Spooling—When a job file is sent over the network by a remote user or imported from
disk, it arrives at the Fiery EX2101 and spools to a location on the hard disk drive.
After spooling completely, the job is held on the hard disk drive, where it awaits further

instructions from the operator.

Processing (RIPping)—When the operator releases the job file, it undergoes raster
image processing (RIPping) at the Fiery EX2101. During processing, the job file is
interpreted as a raster image. This raster image contains the data required by the copier
to print the job the way its originator intended. In the raster image, data associated
with each dot is rendered on the copier. The raster data tells the copier whether or not
to apply toner to each position on the page.

Printing—After processing, the job typically moves on to the printing stage. During
this stage, the raster image associated with the job is transferred from the Fiery EX2101
to the copier at a high speed. The raster image is then rendered onto paper, and the job
is printed.

While original job files are saved to the Fiery EX2101 hard disk drive, raster images are
typically deleted after printing. The operator can issue commands to save and hold the
raster image on the hard disk drive along with the original job file. Saving the raster
image to the hard disk drive offers two advantages: raster files are already processed, so
they print quickly, and each part of the raster file is still identified with a page in the

original document, so you can access individual pages of a saved raster file.
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Visualizing job flow

As the operator, your job management tools permit holding and releasing a job at any
stage of the job flow. In the following illustration, solid boxes indicate the types of job
status flags you may see in the Command WorkStation or Command WorkStation LE
Active Jobs window. Boldface items represent commands you can issue from a job
management utility to release held jobs.

Spooling
PostScript and Spooled/Held
PCL data
Print Process (RIP) and Hold Print and Hold
Processing (RIPping) Processing (RIPping) Processing (RIPping)
PostScript, PCL, v
and raster data Processed/Held

Print

— o
~

Printing Printing — Printing

Y
JEEN

Printed
L _ _ 4
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Each command initiates a job workflow:

Print—When you issue the Print command for a held job, the job is released for
immediate processing and printing on the Fiery EX2101.

Print and Hold—When you issue the Print and Hold command for a held job, the job
is released for immediate processing and printing. However, a raster copy of the
original job remains in processed/held status, even after the original job finishes
printing.

Process (RIP) and Hold—When you issue the Process and Hold command (Command
WorkStation or Command WorkStation LE) or RIP and Hold command (Fiery
WebSpooler or Fiery Spooler) for a held job, the job is released for processing and then
held in processed/held status indefinitely. To release the job for immediate printing,
you must issue the Print command. A raster copy of the original job remains in
processed/held status, even after the original job has finished printing.

Communicating with users

As the operator, you can use the job management tools to communicate with users
who originate print jobs. You can help users become better informed about the

Fiery EX2101 and the copier so that they can choose the appropriate options for their
jobs by supplying the following information:

Fiery EX2101 device information

* The name of the Fiery EX2101 on the network and the names of the network

servers sharing it

* The IP address or DNS name of the Fiery EX2101, to allow users access to
Fiery WebTools™

* List of default copier settings and other settings
e List of installed fonts

If their applications do not download fonts automatically, can users download fonts
to the Fiery EX2101? Should users embed fonts in documents or supply them for

you to download?
* List of installable options for the copier

* Available media, alternative choices, and standard tray/media configurations
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Printing information

¢ Duration for jobs to be held on the Fiery EX2101 before deletion

* Instructions for setting up the printer on client computers

* Sources of PostScript printer drivers, PPDs, and additional information
* Recommended PPD settings

* Conflicting settings and common PostScript errors

¢ FreeForm information regarding use of master and variable data

* Imposition information regarding use of the DocBuilder Pro option

* Requirements for Notes fields (information that appears in the Job Log)

For example, department name, account code, phone number, or extension.

Is particular information mandatory at your site?

* Suggestions for what to enter in the Instructions field

What the operator should check

Users specify print options with jobs they send to the printer. They can also use the
Instructions and Notes fields to communicate special print requirements and
accounting information. Together, this user-specified information that accompanies
the job is called a job ticket.

As the operator, we recommend that you tell remote users which job ticket
information you check when receiving a print job, and the information you require in
order to print jobs they send.
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Job ticket information

You can view and potentially override the print options specified by users by checking
job ticket information. To display user-defined print options, choose Properties in
Command WorkStation or Command WorkStation LE (see page 3-14), or Override
Print Settings in Fiery WebSpooler or Fiery Spooler (see page 7-7).

Notes fields

Users can enter accounting information in the Notes fields, such as:

¢ User name and phone number

* Billing information

¢ Job cost information

Instructions field

Users can also enter information in the Instructions field to communicate special print

requirements, such as:

* Priority, due date, and request for notification

* Number of copies

* Type and quantity of paper

* Request to hold job for future printing or reprinting, and future job instructions
* Instructions to merge job with another job

* FreeForm information regarding the use of master and variable data

* Imposition instructions
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Overview of the job management utilities

The Fiery EX2101 includes the following job management utilities:

* Command WorkStation

* Command WorkStation LE

* Fiery WebSpooler

* Fiery Spooler

These utilities are designed for use by operators who must track and manage jobs and

oversee general job flow through the Fiery EX2101. All the utilities offer the following

job management features:

* Monitoring activity on the Fiery EX2101 and controlling job flow
* Viewing and overriding user-defined print option settings

* Editing and merging job files

* Tracking job activity through the Job Log

Command WorkStation

The most powerful of the job management utilities, Command WorkStation can be
installed on a Microsoft Windows computer that has a network connection to the
Fiery EX2101. In addition to the job management functions previously outlined,
Command WorkStation offers a customizable user interface for monitoring and
managing jobs on multiple Fiery EX2101 servers simultaneously.

For an introduction to the Command WorkStation user interface, see Chapter 2.
For information on monitoring, managing, and archiving jobs with Command
WorkStation, see Chapter 3.

Command WorkStation LE

Command WorkStation LE allows operators and users to manage jobs from a Mac OS
computer with a network connection to the Fiery EX2101.

The features of Command WorkStation LE are similar to those of Command
WorkStation. For information on Command WorkStation LE, see Chapters 2 and 3.
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Fiery WebSpooler and Fiery Spooler

Fiery WebSpooler and Fiery Spooler are similar in appearance and functionality.

However, you access the utilities in different ways. You can access Fiery WebSpooler

through a Java-enabled Web browser residing on any computer with a networked

connection to the Fiery EX2101. Fiery Spooler must be installed on a networked

Mac OS computer and can only be used on that computer.

Both Fiery WebSpooler and Fiery Spooler offer job management functions similar to

those of Command WorkStation. The default Fiery WebSpooler user interface is

shown in the following illustration; the user interface of Fiery Spooler is similar.

WebSpooler - AERO M [=] B3

s Job Pags ‘Window Help

Spool status bar

yellowpeppers_
wordapaltrn.ps Administrator

Spool area
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Q15 RaceCarps Administrator
cookies.ps Adrministrator

RIP status bar

Administratar
Administrator

RIP area

Print status bar
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Print area

Printable Area.pdf Administrator
ps.pdf Administrator
psps Administrator
testpdf Administrator

w/aming: Applet Window

| Time
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07:33:28
07:38:12
07:37.47
07:37:33

06:33:38

0 08
07:44:93
07:34:05
07:34:05
07:34:05
07:34:05

|Date

0141810
01418/03
01418/03
01418/03
01418/03
01/18/03

0141810
01418/03

0141810
01418/03
01418/03
01418/03
01418/03
01418/03

Thumbnail B

Thumbnail A

For more information about using Fiery WebSpooler or Fiery Spooler, see Chapter 7.
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Chapter 2: This chapter provides an introduction to the Command WorkStation and Command

Introduction WorkStation LE graphical user interfaces. To follow along in the software as you read
the chapter, log in to the application with an Operator or Administrator password, as

to Command described on page 3-2.

WorkStation

and Command Once you are logged in, you can tour the application. Your exploration will be more

WorkStation LE complete if you have some jobs in the Active Jobs window (jobs in the Hold queue),

and can send more jobs from a nearby computer.

The chapter also describes Setup functions, such as printing Fiery EX2101
information pages, setting application preferences, and managing Fiery EX2101 fonts.

Note: Unless otherwise specified, information in this chapter applies to both
Command WorkStation and Command WorkStation LE. Sections that apply
exclusively to Command WorkStation are denoted by an asterisk (*). Sections that
apply exclusively to Command WorkStation LE are denoted by a dagger (). In cases
where the two applications are nearly identical, only Command WorkStation

illustrations are shown.

The graphical interface

Command WorkStation and Command WorkStation LE provide graphical means to
monitor, preview, and manage jobs on one or more Fiery EX2101 servers. You can
hide or rearrange the components in the interface to create custom layouts that meet

your job management needs.
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The following illustrations show the components of Command WorkStation and
Command WorkStation LE.

. Command Work5t,
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Held [§ 2Plstter PDF Administrator  1/9/03 11:24:31 AM 1 28766 KB [ Frinting: Idle
Held [ B pdr Administrator  1/9/03 11.08:39 AM 1 40298 KB
Held [ simplex.pdr Administrator  1/9/03 10:18:39 AM 1 19996 KB ] =pooling: Idie
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\Waiting [ Black_Hale.pdf Administrator  1/9/03 1016215 AM 3 33287 KB [ Frinting: testPage
Processing | [ simplex pdf Administrator - 1710003 5:50:30 A 1 199896 KB
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Held £ 508368 Shoprite 5 Administrator  1/9/03 2:24:31 PM 1 33447 KB
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JLbTme User Date/Time Copi
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[ Printer Test Page Administrator  1MB/03 5:29:14 PM 1
[ Printer Test Page Administrator - 11603 5:29:01 PM 1
[} Test Page Administrator  11B/03 3:29:38 PM 1
[} Test Page Administrator 11603 31613 PM 1
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Printed Johs

Command WorkStation

1 Menu bar (see page 2-14)

2 Job status indicators (see page 2-10)
3 Action buttons (see page 2-11)

4 Active Jobs window (see page 2-4)

5 Jobs window (see page 2-5)

6 Activity Monitor (see page 2-8)
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Command Workstation LE

¢
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Archive  Preview  Properties 1

Active Jobs: AERO Tatal
w Job Status Job Title User Date/Time
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Hald D Spanish Ballerin... MichaslP 3/13/03 11:33 AM
Hald D C19.yallowtailps .. MichaslP 3/13/03 11:13 AM
Hald D D45WOP_n1a_... Administrator 3/14/03 B:58 AM
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Command WorkStation LE

1 Action buttons (see page 2-11)
2 Active Jobs window (see page 2-4)

3 Jobs window (see page 2-5)

4 Activity Monitor (see page 2-8)

Engine Under Operation

¥ General Info
Hard Drive
[¢] 25 50 75 100

total: 32.3 GE  available: 27.4 GB

Memory
o 25 50 75 100

C

laf»

total: 32.3 GE  available: 27.4 GB *

The following sections describe each component in Command WorkStation and
Command WorkStation LE.
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Active Jobs window

The Active Jobs window dynamically displays the status and job ticket information of
jobs that are currently being held, processed, or printed on the Fiery EX2101. The title
bar displays the total number of jobs and the total number of held jobs currently being

monitored.

The Active Jobs window is always displayed. You cannot hide or drag it to a different
location. By issuing job management commands, you release held jobs in the window
for processing and printing, cancel jobs currently processing or printing, and send jobs
back to held status for future action. For more information on the status flags displayed
in the Active Jobs window, see “Job status indicators” on page 2-10.

Server selection menu

M

Active Jobs A

Job ticket information

fiery
Job Status | Job Title User DateiTime

Held [4 2Pletter.POF.dhp Administrator 159703 11:28:50 Al 1

Held [4 2Pletter.POF Administrator 159703 11:24:31 AM 1

Held [ Bhvy pdf Adrinistrator — 1/9/03 11:09:39 AM 1

Held [ simplex Administrator /9703 10:18:39 Al 1 =
Held [ Black_Hale.pdf.dbp Administrator /903 10:16:15 Al 1
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Held £ 508368 Shoprite 5.... Administrator 159003 2:24:31 PM 1

Held £ 508378 Shoprite FS... Administrator 159003 2:24:30 PM 1

Held £ 508381 Shoprite .. Administrator 159003 2:24:28 PM 1 -
| | s

Command WorkStation
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Hald [ 045WOP_nta_... Administrator 3/14/03 8:58 AM 1
Hald [ co8.Cookiesps  MichaelP 313703 11:18 AM 1
Hald [ C12.Ditbike_NO... MichaslP 313103 11:19 AM 1
Hald [ c19.yellowtailps  MichaelP 313103 11:12 AM 1
Hald [ co9.Castleps MichaalP 313703 11:18 AM 1
Hald [ C04.GDROP.PS  MichaelP 3113103 11:17 AM 1
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>

Command WorkStation LE
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In the Active Jobs window, you can:
* Monitor and manage jobs on the Fiery EX2101 (see page 3-6)
* Customize job ticket information (see page 3-8)

* Monitor jobs on multiple Fiery EX2101 servers* (see page 2-12)

Jobs window

The Jobs window displays information about jobs that have printed successfully
through a connected Fiery EX2101. The window is divided into four layered panels.
Click the selection tabs at the bottom of the window to move between different panels.

The following illustration shows the Jobs window for Command WorkStation, which
is nearly identical to the Jobs window for Command WorkStation LE.

Y |
||| Printed Johs

Joh Title User DateiTime Copi... Size |~
[§ 2543.P5 Adrministrator  1/10/03 11:26:55 AM 1 126931 KB

[4 Black_Hale.pdf Administrator 100003 11:26:50 AM 1 5108 KB __
[ Anglefish.pdf Administrator 10003 11:26:27 AM 1 439 KB

[ Bhvy pdf Adrministrator — 110/03 11:26:27 AM 1 52317 KB

[ 4poLetterPiGs. pdf Administrator 10003 11:24:21 AM 1 77 kB

[4 Black_Hole.ps Administrator 10003 11:24:21 AM 1 I7TE3IBI KB

[ J.Brahms.ps Administrator 1A 0/03 11:23:44 AM 1 161932 KB

[ pm021tabsipdfps Administrator 1A 0/03 10:07:41 AM 1 935 KB

[ pm021tabsipdf pdf Administrator 1A 0/03 10:07:40 A 1 522 KB =

Printed Jobs tab

In each panel, the title bar displays the name of the panel and the total number of
jobs displayed.

All panels of the Jobs window allow you to customize the job ticket information
(see page 3-8).
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Printed Jobs panel

The Printed Jobs panel lists all jobs that have been printed from the Fiery EX2101.
Newly printed jobs are added to the top of the list. The Printed Jobs panel lists all
printed jobs until the job limit (determined by the administrator in Fiery EX2101
Setup) is reached. When the first job over the limit is printed, the oldest job is deleted
from the Printed Jobs list.

NoTe: The Printed Jobs panel does not list the following types of jobs: those printed
though the Direct queue and those printed with the Print Pages command.

Archive panel

The Archive panel lists all files and jobs stored in the job archive.

||| Archived Jobs Total Johs 2
Jab Title User DatelTime Copi...
[ Documentt Administrator 153503 6:13:44 PM 1
[ Documentt Administrator 153503 5:27:35 PM 1
oS 4 00000000000 B

For information about using the Archive panel, see “Archiving jobs” on page 3-30.
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FreeForm panel

The FreeForm panel lists the names of all master files used for FreeForm variable data
printing. Jobs listed in the FreeForm panel represent master files that have already been
RIPped and stored on the Fiery EX2101.

£ 508378 Shoprite FS... Administrator 159003 2:24:29 PM
£ 508381 Shoprite .. Administrator 159003 2:24:28 PM 1

The FreeForm panel is not available if you logged in as Guest. For information on
working with FreeForm jobs and the FreeForm panel, see page 3-27.

Job Log panel

The Job Log panel lists all processed and printed jobs and includes the date and time
the jobs were printed.

||| Job Log

Frint Status | Jab Title User DatelTime Size [~
[s]%¢ [ hittp:ifwenee raman... Pat 312003 5:18:20 PM 311 KB
[s]%¢ [ hittp:ifwenee raman... Pat 3200351752 PM 256 KB —
[s]%¢ [ hittp:ifwenee raman... Pat 320351721 PM 253 KB
[s]%¢ [ hittp:ifwenee raman... Pat 312003 5:16:37 PM 343 KB
[s]%¢ [ Dsfinaloutput? pdf Leslie 312003 4:51:43 PM 4573 KB
o]'4 [4 start Page Operator 312103 44311 PM 1201 KB
o]'4 [4 start Page Operator 31203 41525 PM 1201 KB
o]'4 [ Online Membership... sam 3112103 4:05:06 PM 46 KB
o]'4 [4 start Page Operator 312103 4:03:35 PM 1201 KB =
.|

The Job Log panel is not available if you logged in as Guest. For information on using
the Job Log panel, see page 3-32.
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Activity Monitor

The Activity Monitor displays a summary of the job activity on all Fiery EX2101
servers or a selected Fiery EX2101. The activity shown can include jobs released
for spooling, processing (RIPping), or printing. Held jobs do not appear in the
Activity Monitor.

Display the Activity Monitor by choosing Activity Monitor from the Windows menu.
In Command WorkStation, you can use the server selection menu in the Active Jobs
window to display job activity for an individual Fiery EX2101, or for all servers

(see page 2-12).

ALl Servers view*

In Command WorkStation, the All Servers view of the Activity Monitor summarizes
the activity on all connected Fiery EX2101 servers.

=
« AERO

[ Spooling: Idle
[ Processing: [dle
[ Printing:

Mo fuser oil

fwer ]
[ Spooling: Idle

[ Processing: [dle

[ Printing: Idle

* Server Name—ZEach Fiery EX2101 appears in a Server Name bar. Click the bar to
expand or collapse activity information for a particular Fiery EX2101.

* Spooling, processing, and printing jobs—When you expand the Server Name bar
for an Fiery EX2101, any current job activity on that Fiery EX2101 appears next to
a corresponding status box (spooling, processing, or printing). If the Command
Workstation for the Fiery EX2101 is connected to more than one copier, the copier
handling the job is listed under the job name. When no activity occurs on the
Fiery EX2101, the status boxes read Idle.

¢ Error conditions—When an error occurs, the Server Name bar for the affected
Fiery EX2101 appears highlighted in red. Details of the error appear under the
expanded bar.
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Selected Server view

When you select an individual Fiery EX2101 in Command WorkStation, the Activity
Monitor provides a more detailed summary of the current activity on that
Fiery EX2101. In Command WorkStation LE, the Activity Monitor always displays

the current activity on the connected Fiery EX2101. Animated images provide visual
indications of the job activity.

Jobs being held, waiting to process, or waiting to print are not displayed.

The following illustration shows the Selected Server view of the Activity Monitor for
Command WorkStation, which is nearly identical to the Activity Monitor for
Command WorkStation LE.

Spooling

Processing

Printing

= Printing
idle

General Info

~ General Info

Hard Drive
0 25 50 75 100
L —

Total 17.6 GB Available: 17.5 GB

hermory

0 25 50 75 100
L —

Total_31.0 MB_Available: 31,0 M8
Infi

Server Name: AERO

System: 1

Support #:

Device  <clevice_name=

Four sections appear for a selected server. Click the title bar for each section to expand
or collapse the display of each section.

Spooling—Displays the file name of the job spooling to the Fiery EX2101 hard disk.

Processing—Displays the file name of the job currently being processed (RIPped),
along with an animated preview of the page currently being processed.
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[T spooling [ spoolediheld

Printing—Displays the file name of the job currently being printed, and the page
number currently printing. With multiple copies, the copy number is also displayed.

General Info—Displays the total and available hard disk drive space, and the total and
available memory of the Fiery EX2101. This section also provides the Fiery EX2101
name, system software version, technical support number, and copier name.

Job status indicators

Job status indicators define the color in the Active Jobs window and Activity Monitor
to indicate the current status of jobs. For information on how each indicator relates to
job flow on the Fiery EX2101, see “Understanding job flow” on page 1-2.

In Command WorkStation, a key for the job status indicators is displayed below the
menu bar:

[ Iwaiting to pracess [ | processing [ | processedtheld [ Jwaiting ta print [ | printing

The color-coded job status indicators identify:
spooling (white)—The job file is being copied to the Fiery EX2101 hard disk drive.

spooled/held (light yellow)—The job has been downloaded to the Fiery EX2101 hard
disk drive and requires job management instructions from the operator.

waiting to process (light blue)—The job is queued to be processed (RIPped).
processing (medium blue)—The job is currently being processed (RIPped).

processed/held (dark yellow)—The job has been processed (RIPped) and requires job

management instructions from the operator.

waiting to print (light green)—The job is queued to be printed on a copier connected
to the Fiery EX2101.

printing (bright green)—The job has been received by a copier connected to the
Fiery EX2101.
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Action buttons

Action buttons provide convenient access to frequently used job management
commands. You can also issue these commands by choosing them from the menu bar
or the context-sensitive menus. For a detailed description of each Action button
command, see the table on page 2-14.

| Frint | Hald | Process/Hald | Delete | Archive | Presvigw | Impioze | Properties

Command WorkStation

e B L@ ] e

Hold  Process/Hold  Delete  Archive  Preview

Command WorkStation LE

To ISSUE AN ACTION BUTTON COMMAND
1. Select a job in the Active Jobs window or the Jobs window.

2. Click the desired Action button.

When a command is unavailable in the current context, its Action button appears
dimmed.

Preview windows

The Preview windows allow you to view thumbnail previews of selected jobs. You can
also use the Preview windows to reorder and delete pages of a job, and to merge pages
from several jobs into a single, merged job.
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Monitoring single or multiple Fiery EX2101 servers*

In Command WorkStation, you can set the Active Jobs window, Jobs window, and
Activity Monitor to display job information for a single Fiery EX2101 or all connected
Fiery EX2101 servers.

To SPECIFY THE FIERY EX2101 BEING MONITORED

1.

Click the arrow in the server selection menu of the Active Jobs window, Jobs window,
or Activity Monitor.

A menu appears, listing the names of all connected Fiery EX2101 servers.
To display jobs for an individual Fiery EX2101, choose the Fiery EX2101 from the list.
To monitor jobs for all connected Fiery EX2101 servers, choose All Servers.

Print jobs on the specified Fiery EX2101 servers are displayed.

Customizing the graphical interface

Command WorkStation and Command WorkStation LE offer you the flexibility of
showing, hiding, rearranging, and docking user interface components to fit your
workflow needs. For example, you may only need a few components, or you may
prefer to arrange components side by side for ease of use. In Command WorkStation,
you can also choose one of three preset layouts.

You can also customize the appearance of job ticket information in the Active Jobs and
Jobs windows. For more information, see page 3-8.

Using layout styles*

Command WorkStation provides three preset and three customizable layout styles.
When you choose the command corresponding to a layout style, the display updates to

show a specific arrangement of components.
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To SELECT A LAYOUT STYLE

Choose Layouts from the Window menu, and then choose a layout style from the
submenu that appears.

You can choose one of three preset layouts (Default, Style 1, or Style 2) and three
custom layouts. For a description of the components included with each of the preset
layouts, see page 2-20.

You can define and change the configurations associated with the three custom layout
styles. For details, see the following section.

Showing, hiding, and arranging components

Use Window menu commands to show or hide window components. You can also
drag components to different locations in the window, and dock components side

by side.

NoTE: You cannot hide or drag the menu bar or Active Jobs window to different
locations. These components always appear in the Command WorkStation or
Command WorkStation LE window.

To SHOW OR

HIDE A COMPONENT
Choose the command associated with the component from the Window menu.

When a component is displayed, a check mark appears next to it in the

Window menu.

To MOVE A COMPONENT TO ANOTHER LOCATION

Click the window grip (three vertical lines) on the left side of the component’s title
bar (Command WorkStation) or click the component'’s title bar (Command WorkStation
LE), and drag the window to the desired location.

Undocked components float in front of other components and appear with standard
window frames. Drag the blank title bar of the window to move the component, or
drag the edges of the window to resize the component. You can also click the window
Close box to hide the component.

NoTe: When the Jobs window is docked, you can resize it vertically by clicking and
dragging its top edge.
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TO DOCK OR UNDOCK A COMPONENT

e Double-click the window grip in the component’s title bar.

To SAVE THE CURRENT DISPLAY CONFIGURATION AS A LAYOUT
STYLE IN COMMAND WORKSTATION*

1. Choose Save Layout from the Window menu.

2. In the dialog box that appears, choose the style you want to update, and, if desired,
rename the style.

3. Click OK to save the new layout style.

Using commands

You can perform a wide variety of functions using Command WorkStation and
Command WorkStation LE commands, which you access from menus in the menu
bar at the top of the Command WorkStation or Command WorkStation LE window.
When one or more jobs are selected, you can choose job management commands from
context-sensitive menus. In addition, you can issue some job management commands
by clicking their Action buttons (see page 2-11).

Menu bar

The menu bar contains commands for Command WorkStation or Command
WorkStation LE. When a command is unavailable in the current context, it appears
dimmed in the menu. When a command appears with a check mark, choosing it again
toggles the command, turning it off.

The menu bar always appears in the Command WorkStation window and cannot be
dragged to a different location.

Note: In the following table, an asterisk (*) indicates that the command or menu is
available for Command WorkStation only. A dagger (1) indicates that the command or
menu is available for Command WorkStation LE only.
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Menu Command Submenu command Description
CWS LEf | About Fiery Displays information about the current version of

Command Command WorkStation LE.

WorkStation LEt

Preferencest Allows you to change the Command WorkStation LE
preference settings.

ServicesT The commands under this submenu are disabled for
Command WorkStation LE.

Hide CWS LET Minimizes and hides the Command WorkStation LE
application window. The application continues to run in
the background.

Hide Others? Minimizes and hides all currently running applications,
other than Command WorkStation LE. The hidden
applications continue to run in the background.

Show Allf Maximizes and brings to the foreground all applications that
are currently running on the computer.

Quit CWS LEf} Exits the Command WorkStation LE application.

File Import Job Imports a job file into the Direct, Hold, or Print queue of
the Fiery EX2101.
Archived Job Imports an archived job file into the Hold queue of the
Fiery EX2101.
Export Active Window* Exports the contents of the Active Jobs window to a

tab-delimited text file.

[current panel of Jobs
Window]*

Exports the contents of the current panel of the Jobs window
to a tab-delimited text file.

Job Listt Exports the contents of the Active Jobs window to a
tab-delimited text file.
Job Logt Exports the contents of the Job Log panel to a tab-delimited

text file.
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Menu Command Submenu command Description
File Print* Job Log* Prints the current Job Log on a local printer.
(cont.)
Active Window* Prints the contents of the current window on a local printer.

Exit* Closes the Command WorkStation application window.

Closet Closes the Command WorkStation LE application window.

Edit Find Allows you to search selected Fiery EX2101 servers for jobs
that match certain search criteria.

Preferences* Allows you to change the Command WorkStation
preference settings.

Undo, Cut, Applies the specified action on the selection. For more

Copy, Pastet information, see Mac OS Help.

Actions Print Prints the selected job in the Active Jobs window, Printed
Jobs panel or Archive panel.

Delete Deletes the selected job in the Active Jobs window, Printed
Jobs panel, FreeForm panel, or Archive panel.

You cannot delete jobs currently spooling, processing, or
waiting to print.

Duplicate Duplicates the selected held job in the Active Jobs window.

Rename Allows you to rename the selected held job in the Active Jobs
window, or the selected job in the Printed Jobs panel or
Archive panel.

Hold Holds the selected job waiting to process in the Active Jobs
window, or the selected job in the Printed Jobs or Archive
panel, and marks the job with either the spooled/held flag or
the processed/held flag.

Process and Hold Processes the selected job in the Active Jobs window, Printed
Jobs panel, or Archive panel, and holds a copy of the job.
The copied job is marked with the processed/held flag.

Print and Hold Prints the selected job in the Active Jobs window, Printed

Jobs panel, or Archive panel, and holds a copy of the job.
The copied job is marked with the processed/held flag.
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Menu Command Submenu command Description
Actions Remove Raster Removes the raster data associated with the selected
(cont.) Data processed/held job in the Active Jobs window, or the selected

raster job in the Printed Jobs or Archive panel; leaves the
original PostScript job in place.

Properties

Allows you to view and override print settings for the
selected job in the Active Jobs window or Printed Jobs panel,
or view print settings for the selected job in the FreeForm
panel or Archive panel.

Preview

Opens the selected job in a Preview window. You can
preview held jobs that reside in the Active Jobs window, as
well as jobs that reside in the Printed Jobs panel, FreeForm
panel, or Archive panel.

Archive

Archives the selected held job in the Active Jobs window,
moving it to the Archive panel.

Send To*

Sends the selected held job in the Active Jobs window to
another Fiery EX2101.

Cancel Processing

Cancels processing of the selected job in the Active Jobs
window. This command is available only for jobs displaying
the processing status flag.

Cancel Printing

Cancels printing of the selected job in the Active Jobs
window. This command is available only for jobs displaying
the printing status flag.

Impose* Allows you to apply imposition settings to the selected held
job in the Active Jobs window.

Insert Tabs* Inserts tab pages in the selected, spooled/held job in the
Active Jobs window.

Mixed Media Allows you to specify different media types for different page

Setup* ranges in the selected spooled/held job.
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Menu Command Submenu command Description
Server Log In/Log Out Allows you to log in or log out of the Fiery EX2101 and add
or remove Fiery EX2101 servers from the list.
Setup* Opens the Setup options for the Fiery EX2101.

Manage Font

Allows you to download fonts to the Fiery EX2101. You can
also delete fonts that you have downloaded to the
Fiery EX2101.

Insert Tabs Setup*

Allows the Fiery EX2101 Administrator to set up templates
for printing on tab media stock.

Align Trays*

Allows you to adjust placement of the printed image on the
page to correct for misalignments of the paper tray.

Printing Groups*

Allows the Fiery EX2101 Administrator to set up printing
groups and passwords. For more information about Printing
Groups and Secured Print (Member Printing), see the
Configuration Guide.

Reorder Jobs*

Allows you to reorder the priority of jobs that are waiting to
process or print.

Restart Server

Allows you to restart the Fiery EX2101 without shutting
down the Fiery EX2101 hard disk drive. This command is
available only if you are logged in as Administrator.

NOTE: After you restart the Fiery EX2101, you may have to
log in to the Fiery EX2101 again to reestablish the
connection.

Reboot Server

Allows you to restart the Fiery EX2101, after shutting down
the Fiery EX2101 hard disk drive. This command is
available only if you are logged in as Administrator.

NOTE: After you restart the Fiery EX2101, you may have to
log in to the Fiery EX2101 again to reestablish the

connection.
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Menu Command Submenu command Description
Server Job Log* Export* Exports the contents of the Job Log panel to a tab-delimited
(cont.) text file.
Export and Clear* Exports the contents of the Job Log panel to a tab-delimited
text file, and clears the contents of the job log for the
Fiery EX2101.
Clear Job Logt Clears the contents of the job log for the Fiery EX2101.

Clear Server

Allows the administrator to clear or delete the following file
types from the currently selected server: Held Jobs, Active
Jobs, Printed Jobs, Archived Jobs - Server Internal, Archived
Jobs - Network Links, FreeForm Masters, Job Log, and
Scan Jobs.

Print Pages

Allows you to print the following information pages:
e DS Test Page
e PCL Test Page
* Configuration page
e Job Log
* DS Font List
e PCL Font List
e E-mail Log

Command WorkStation also allows you to print the
following information pages about the Fiery EX2101 to the
local printer:

* Archive Log

* Queues

Suspend Printing

Suspends or pauses printing on the Fiery EX2101.

Resume Printing

Resumes printing on the Fiery EX2101.
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Menu

Command

Submenu command

Description

Window

Layouts*

Default*

Displays the following Command WorkStation
components:

¢ Menu bar

* Job Status Helper

¢ Action buttons

¢ Active Jobs window

¢ Jobs window

¢ Activity Monitor (selected server view)

Style 1*

Displays the following Command WorkStation
components:

¢ Menu bar

¢ Job status indicators

¢ Action buttons

¢ Active Jobs window

Style 2*

Displays the following Command WorkStation
components:

* Menu bar

¢ Job status indicators

* Action buttons

¢ Active Jobs window

* Activity Monitor (all servers view)

Custom 1, Custom 2, or
Custom 3*

Sets the Command WorkStation window to a custom layout
previously defined and named using the Save Layout
command.

Save Layout™®

Allows you to save and name the current Command
WorkStation display as a custom layout. Saved layouts
appear as commands in the Window > Layouts submenu.
You can save up to three custom layouts.

Jobs Window

Switches the Jobs window on or off. A check mark next to
the command indicates that the Jobs window is displayed.
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Menu Command Submenu command Description
Window Activity Monitor Switches the Activity Monitor on or off. A check mark next
(cont.) to the command indicates the Activity Monitor is displayed.
Action Buttons* Switches the Action buttons on or off. A check mark next to
the command indicates the buttons are displayed.
Job Status Helper* Switches the Job Status Helper on or off. A check mark next
to the command indicates the helper is displayed.
Tile Preview Displays active Preview windows in tiled formation so that
Windowst the windows are simultaneously visible.
Cascade Preview Displays active Preview windows in cascading formation so
Windowst that the windows are stacked with their title bars visible.
Preview— <Job Activates the open Preview window of the named job.
Name>* This menu option appears for each open Preview window.
<Job Name>* Activates the open Preview window of the named job.
This menu option appears for each open Preview window.
More Previews* Opens a Previews window, where you can activate, close,
cascade, and minimize the open Preview windows.
Help* About Command Displays information about the current version of

WorkStation*

Command WorkStation.
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Context-sensitive menus

When you select one or more jobs in the Active Jobs or Jobs window, you can display
context-sensitive menus containing job management commands for selected jobs.

To DISPLAY A CONTEXT-SENSITIVE MENU

1.

Select one or more jobs in the Active Jobs or Jobs window.

For details on how to select jobs, see page 3-7.

Right-click the selected job (Command WorkStation) or Control-click the selected job
(Command WorkStation LE).

When multiple jobs are selected, you can right-click or Control-click any of the

selected jobs.

Choose the desired command from the context-sensitive menu.

Preparing to work with Command WorkStation or
Command WorkStation LE

This section describes the setup and administrative tasks required to begin working
with Command WorkStation or Command WorkStation LE.

Connecting to the Fiery EX2101

In Command WorkStation, you can maintain connections to multiple Fiery EX2101
servers simultaneously. In Command WorkStation LE, you can maintain a connection
to one Fiery EX2101 server at a time.

To CONNECT T0 THE FIERY EX2101

1.

Choose Log in/Log out from the Server menu.

The server list is displayed.

Select the Fiery EX2101 from the list of Fiery EX2101 servers you have connected
to before.
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The server list displays the Fiery EX2101 servers you can monitor and manage from
Command WorkStation or Command WorkStation LE. You can add and remove
Fiery EX2101 servers from the list of Fiery EX2101 servers you frequently monitor.

Diame
T LUCY (255.255.255 255)
#
@ AERD (104112.13)
Login button
Remove

Command WorkStation

| Name

s -, 109114773 (10.11.147.73)

_ < RUSWEG (10.10537)
Login button |

EC=
=

Command WorkStation LE

|

Each row in the server list displays the name of a Fiery EX2101, the name of the copier
associated with that Fiery EX2101, and a Login button (represented by a key icon).

3. Click the Login button next to the Fiery EX2101 name to establish the connection.
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4. In Command WorkStation, click the Administrator, Operator, or Guest button, enter
your password, and then click Log In. In Command WorkStation LE, enter your
password and click the administrator, operator, or guest button.

Login : AERD E

s Administrator

o Operator
_’ﬂ Guest

Command WorkStation

® O O Logi..

’i administrator
——
’ﬁ —

—

Command WorkStation LE
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Printing Fiery EX2101 information pages

Use the Print Pages command to print information about the Fiery EX2101. The

pages provide useful reference information for setting up or troubleshooting the
Fiery EX2101.

To PRINT FIERY EX2101 INFORMATION PAGES

1.

2.

In the Active Jobs window, select the Fiery EX2101 for which you want to print
information pages.

Note: To print information pages, you must be logged in to the Fiery EX2101 with
Administrator privileges.

Choose Print Pages from the Server menu.

A dialog box containing the information page options appears.

Note: Local Printer options are available in Command WorkStation only.

Print Pages - AERD Print Pages - AERD |
Select Printer — Select Printer

&+ Server 7 Server

€ Local Prirker & Local Prinker
Select Pages Select Pages
[C1PS Test Page [ larchive Log
[]PCL Test Page [Queues
[ 1Configuration
[1Job Log
[1PS Font List
[C1PCL Font List
[1E-mail Log

Eritif... | Eritif... | Cancel |

Server options Local Printer options

For Command WorkStation, in the Select Printer area, specify where you want to print
the pages.

Server—The pages you specify are printed to the Fiery EX2101.

Local Printer—Allows you to print the Archive Log and Queues to any printer
installed on your Windows computer.
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4.,

In the Select Pages area, specify the pages you want to print.
Each set of pages contains specific information about the Fiery EX2101.
You can print the following pages from the Fiery EX2101:

PS Test Page/PCL Test Page—Allows you to confirm that the Fiery EX2101 is properly
connected to the copier, and provides grayscale samples to troubleshoot problems with
the copier or the Fiery EX2101. The following settings are among those listed on the
Test Page: Server Name, Printer Model, date and time the Test Page was printed.

Configuration—Provides the current Fiery EX2101 and copier configuration. This
page lists general information about the hardware and software configuration of the
Fiery EX2101, current settings for all Setup options, and the network addresses of the
Fiery EX2101.

Job Log—Lists a log of the last 55 jobs processed or printed. For information on the
fields in the Job Log and printing it in other forms, see “Using the Job Log” on
page 3-32.

PS Font List—Lists all PostScript fonts currently resident on the Fiery EX2101 hard
disk drive.

PCL Font List—Lists all PCL fonts currently resident on the Fiery EX2101 hard disk.

E-mail Log—Lists a log of the last 55 E-mail printing status reports, information that
can be useful to the network administrator. The reports cover printing or scanning via
the E-mail printing feature, monitoring the address book, and overall transmissions.
Before you can print the E-mail Log, you must enable the E-mail printing feature

in Setup. For details, see the Configuration Guide.

When you select the Local Printer option in Command WorkStation, you can print
the following pages:

Archive Log—Lists all jobs displayed in the Archive panel.

Queues—Lists all jobs displayed in the Active Jobs window.

Click Print.

Fiery EX2101 information pages printed with the Print Pages command appear in the
Fiery EX2101 Job Log with the user name Operator, even if you logged in as
Administrator.
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Setting preferences

The Preferences dialog box enables you to control application settings.

TO SET PREFERENCES FOR COMMAND WORKSTATION*

1.

2.

Choose Preferences from the Edit menu.

The Preferences dialog box appears.
=

—E |
General

[T Enable Arimation
¥ Autologin [ Enable ToolTips

Temporary path: ID\TEMP Browse... |

r— Impogition

Urits: I Faintz = l

Template Path: IE:\Program Files\Common Files‘Ele  Browse... |

— Search
Template Paths: I Browse... |
—Job Log
Riecords Limit (min 500, max 99939) 500

Export File Format:
' Comma Separated
' Tab Delimited

()8 I Cancel |

Specify the desired preference settings, and click OK to save your settings.
You can specify the following preferences:

Enable Animation—Enables the display of animated graphics in the Selected Server
view of the Activity Monitor (see page 2-9).

Autologin—Instructs Command WorkStation to remember the last access level and
password used to log in to each Fiery EX2101. When you log in to the Fiery EX2101
again, Command WorkStation automatically populates the Login dialog box with the
previous access level and password.
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Enable ToolTips—Enables the display of ToolTips, or context-sensitive text which
appears when you move the mouse pointer over particular buttons and options in
Command WorkStation.

Temporary path—Specifies the folder where Command WorkStation temporarily stores
copies of the jobs you edit or change. Change the temporary path by clicking Browse
and specifying a folder.

Imposition: Units—Specifies the units of measurement used to display attributes, such
as page sizes and custom sizes, in the Job Properties dialog box and Imposition
window.

Imposition: Template Path—Specifies the folder where template files for imposition are
stored for later use. To change the template path, click Browse and specify a folder.

Search: Template Paths—Specifies the folder where Find/Search templates are stored
for later use. To change the template path, click Browse and specify a folder.

TO SET PREFERENCES FOR COMMAND WORKSTATION LE¥

1.

2.

Choose Preferences from the CWS LE menu.

The Preferences dialog box appears.

8 OC Preferences

[ show Import Options Dialog

[7] Use Metric Units
-

# Show Animations

N—

Specify the desired preference settings, and click OK to save your settings.
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You can specify the following preferences:

Show Import Options Dialog—Displays a dialog box that allows you to specify
the destination queue (Hold or Print) for each job imported into Command
WorkStation LE.

Use Metric Units—Specifies the units of measurement used by Command WorkStation
LE to display values that you enter manually in the Job Properties dialog box.

Show Animations—Enables the display of animated graphics in the Activity Monitor
(see page 2-8).

Correcting tray alignment*

The Tray Alignment feature in Command WorkStation allows you to adjust the
placement of text and images on the page so they are correctly aligned on the sheet of
paper, or both sides of a duplex sheet have exactly the same alignment.

You can perform tray alignment from the Fiery EX2101 Control Panel by choosing
Tray Alignment from the Functions menu.

Note: To perform tray alignment, you must be logged in to the Fiery EX2101 with
Administrator privileges.

TO ALIGN TEXT AND IMAGES FOR PRINTING*

1.

In the Active Jobs window of Command WorkStation, select the connected
Fiery EX2101 for which you want to perform Tray alignment.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu.

Choose Align Trays from the Server menu.
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7.

A dialog box containing the Tray Alignment options appears.

Paper Tray Alignment - AERD x|

1. Select trays

Tray Media
<tray sekection> j ILetter j

Last Alignment 171403

2. Print Alignmenit Page

IV Prirt duplex Frirt |

3. Enter alignment values

Side 1 Side 2
& B © &
|7|E IE IE |7|E IE 25 Defaults |

Apply | Check alignment |

Done

Choose the tray you want to align from the Tray menu.

Choose the paper size loaded in the tray from the Media menu.

Note: The Tray Alignment is specific to the combination of tray and paper size
specified. If you align a given tray with Letter paper, and load Legal paper in that tray,
the alignment will be invalid. You must perform a new Paper Tray Alignment for each
combination of tray and paper size.

In the Print Alignment Page section, select the Print Duplex option to print a duplex
page, or clear the option to print a simplex page.

Click Print to print the alignment page.

Once the page has printed, follow the directions on the alignment page.

Fold the page exactly in half horizontally, unfold it, and then fold it in half vertically.
When you unfold the sheet again, you can see that the fold lines cross three scales on
three sides of the page. Determine which number on the scale each fold line crosses.
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10.

11.

In the Enter alignment values section, enter the value where the fold crosses each of
the three scales, marked A, B, and C, for Side 1. If you choose to align for duplex
printing, enter the values for the three scales on Side 2 of the page, as well.

NoTE: If you enter different values in A and C, the image will rotate, leading to uneven
areas on printed output. If this occurs, enter the same value in A and C.

When you have entered all of the alignment values, click Apply, and then click Check
Alignment to print the new alignment page.

To remove the alignments, select a tray and click Defaults in the Enter alignment
values section.

Click Done.

Managing Fiery EX2101 fonts

The Fiery EX2101 includes a number of built-in printer fonts. You can download
additional fonts to the Fiery EX2101 using the Manage Font command in Command
WorkStation. Users on the network can also download fonts to the Fiery EX2101
using Fiery Downloader™ (see the Printing Guide).

Note: To manage fonts, you must be logged in to the Fiery EX2101 with
Administrator privileges.

Downloading fonts, either from Command WorkStation or with Fiery Downloader,
requires that the Direct connection be published in Setup (see the Configuration
Guide).

Note: You cannot download TrueType fonts. If you use TrueType fonts in Windows,
you can print them by converting them to Adobe Type 1 fonts. To convert TrueType
fonts with the Adobe PS printer driver, click the Fonts tab and set up the Font
Substitution Table, as necessary.

To print a list of fonts currently resident on the Fiery EX2101, use the Print Pages
command (see page 2-25).
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TO MANAGE FONTS

1.

2.

In the Active Jobs window of Command WorkStation, select the connected

Fiery EX2101 for which you want to manage fonts.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu to

display it.

Note: To manage fonts, you must be logged into the Fiery EX2101 with

Administrator privileges.

Choose Manage Font from the Server menu.

Locked fonts

Click to update the Font List display

Click to download additional fonts

Click to delete font(s)

Downloaded fonts

Server Fonts E
Mame
Sy Helvetica-Oblique ;I Update i
5 Symbol
B TimesBold add. |
5 Timez-Bolditalic
5 Timez-talic DElete II
& Timez-Roman ~
AvantGarde-Book Frint... I|
AvantGarde-BookOblique
AvantGarde-Demi
Awantl arde-Demillbliooe LI
Ok |

Command WorkStation

Click to print the Font List

[CX)5) Font List

Print List

Typa Lackad Name

PS Yes AdabeSanshiM
PS Yes AdobeSarifMM i
PS Yas AlbertushT
PS Yes AhertushT-ltalic
Ps Yes AlbertusMT Light
PS Yes AntiquaOlive-Bokd
PS Yes AntiquaOlive-Compact
PS Yes AntiqueOlive-talic
PS Yes AnfiqueOlive-Roman
PS Yas Appls-Chancary
PS Yes AriakBalditalicMT
Ps Yes Arial BakiMT
PS Yes Arial-ItalicMT
PS Yes ArialMT
PS Yes AvaniGarde-Book
PS Yes AvaniGarde-BookOblique -
PS Yas AvantGarde-Dami .
PS Yes AvantGarde-DemiObliqua b4

Command WorkStation LE

Click to print the Font List
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3.

6.

7.

Select the PostScript or PCL option to specify the type of fonts displayed.

To download additional fonts to the Fiery EX2101, click Add. For Command
WorkStation, see the procedure on page 2-33. For Command WorkStation LE, see the
procedure on page 2-34.

To delete a font, select it in the Font List and click Delete.

To select multiple sequential fonts in Command WorkStation, select the first font and
Shift-click the last font; Ctrl-click to select multiple non-sequential fonts.

Note: The printer fonts included with the Fiery EX2101 (built-in fonts) are locked.
These fonts appear with a lock icon next to the name (Command WorkStation) or
with “True” in the Locked column (Command WorkStation LE) and cannot be

deleted.
In Command WorkStation, to refresh the Font List, click Update.

To print the Font List, click Print (Command WorkStation) or Print List (Command
WorkStation LE).

To ADD FONTS IN COMMAND WORKSTATION*

1.

In the Select Files to Import dialog box, choose the file types to display from the File
of type menu.

All Known Formats lists all files in supported formats; All Files lists all files.

Select Files to Import

Laoak in: I AFonts
lucor b autiook. t tirnes. t
mapsym. it raman.fon =1 10.tmp timeshd. tf
moder. fon Schibk.ttf sr1F.tmp time:shi.
msgothic. i Schibkb.tf symbal i tirnesi. tf
mtestra tf Schibkbi ti tahama.tf Timnreb. ttf
mtsorts Schlbki tf tahomabd tf 100001 _tf
Filename: I"script.fon"

File of type: |4l Files (7] =l Cancel

Filez to be imported:
CAWANNT YFontshmodern. fon Add

Eemoye

[Hptions..

tLLEE .

) . - |mport
Logical Printer: | &r0 direct j Impor
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2. In the Look in menu, browse to the folder containing the font(s) you want to
download.

The Filename field displays the name of the selected file.

3. Select the font name and click Add.
You can navigate to different drives and folders to select fonts to download.

To select multiple sequential fonts, select the first font and Shift-click the last font.
Cirl-click to select multiple non-sequential fonts.

To remove a font from the Files to be imported list, select the font name and click
Remove.

4. When all the desired fonts appear in the Files to be imported list, click Import.

To ADD FONTS IN COMMAND WORKSTATION LET

1. In the Open dialog box, navigate to the folder containing the font(s) you want to

download.
Open
Select file
From: [ [Z Fonts H-!

E’j Displays N . _A Apple LiGat...dium.dfont
[ oros - Q [A AppleGothic.dfont m
l'j Extensions > _A AquaKanaBold.otf
[™ Extensions.kextcache A AquakanaRegular.atf

= " Al Courier.dfont
_ Extensions.mkext = y
[ Filesystems p | A Genevadfant
= i [A Hei.dfont e
% Find r‘_‘Hl o Y
ﬁ Fonts o _A lelvetica.dfont ;
( e I

Go to:

Add to Favorites ¢ Open )

y

2. Select the font name and click Open.
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3-1 | Starting up and logging in

This chapter describes how to use Command WorkStation and Command
WorkStation LE to monitor and manage job flow on the Fiery EX2101. Once you log
in to the Fiery EX2101 with Operator privileges, you can view jobs held on the

Fiery EX2101 and issue commands to release the jobs for processing or printing. You
can also modify job properties, such as FreeForm variable data printing requirements,
paper settings, finishing options, and other print option settings. After a job has
printed successfully, you can store it in the job archive and view a record of its activity
in the Job Log.

For background information on job flow and job management, see Chapter 1. For an
introduction to the Command WorkStation and Command WorkStation LE user
interfaces, see Chapter 2.

NoTe: Unless otherwise specified, information in this chapter applies to both
Command WorkStation and Command WorkStation LE. Sections that apply
exclusively to Command WorkStation are denoted by an asterisk (*). Sections that
apply exclusively to Command WorkStation LE are denoted by a dagger (1). In cases
where the two applications are nearly identical, only Command WorkStation
illustrations are shown.

Starting up and logging in

To begin working with Command WorkStation or Command WorkStation LE, start
the application and log in to the Fiery EX2101.

To START COMMAND WORKSTATION *

Click Start on the Windows taskbar, choose Programs >Fiery or All Programs > Fiery
(Windows XP and Server 2003 only), and then choose Command WorkStation 4.

When you start Command WorkStation for the first time, the Login Server list does
not display any Fiery EX2101 servers. For instructions on configuring and adding
Fiery EX2101 servers to the Login Server list, see the User Software Installation Guide.
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To START COMMAND WORKSTATION LET

1.

Open the Command WorkStation LE folder, located inside the Applications folder on
the Mac 0S X hard disk.

Double-click the CWS LE file to start the application.

When you start Command WorkStation LE for the first time, the server list does not
display any Fiery EX2101 servers. For instructions on configuring and adding
Fiery EX2101 servers to the server list, see the User Software Installation Guide.

Logging in to the Fiery EX2101

To establish a connection to the Fiery EX2101 listed in the server list, log in to the
Fiery EX2101.

In Command WorkStation, you can maintain connections to more than one

Fiery EX2101 at a time. Each Fiery EX2101 connection requires an average of 4MB of
RAM. The maximum number of simultaneous Fiery EX2101 connections is limited
only by the amount of RAM available on the system running Command WorkStation.
For example, if your system has 128MB of RAM and is running Command
WorkStation exclusively, you can log in to approximately 25 Fiery EX2101 servers at

one time.

To LOG IN TO THE FIERY EX2101

1.

Choose Log in/Log out from the Server menu.

The server list appears.

Click the key icon for the desired Fiery EX2101.

The Fiery EX2101 must appear in the server list before you can log in to it. A white
key icon indicates the Fiery EX2101 has never been connected to Command
WorkStation or Command WorkStation LE.
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#: Login Server

Maime:
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Key icon @
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Command WorkStation
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Command WorkStation LE

Remove button
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If the Fiery EX2101 is already connected, the color of the key icon indicates the level
of access granted:

* Purple indicates Administrator access.
* Orange indicates Operator access.

* Cyan indicates Guest access.
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The Login dialog box appears.

Login : AERD E

s Administrator

— Operator
m \ Guest

Command WorkStation

8 O O Login...

’i administrator
—_—
—

=

Command WorkStation LE

3. In Command WorkStation, click the Administrator, Operator, or Guest button, enter
your password, and then click Log In. In Command WorkStation LE, enter your
password and click the administrator, operator, or guest button.

This manual assumes you are logged into the Fiery EX2101 as Operator. The

following section discusses the three different access levels in greater detail.



3-5 | Starting up and logging in

Access levels

The three possible levels of access to Command WorkStation or Command
WorkStation LE are Administrator, Operator, and Guest. To enable maximum
password protection, Administrator and Operator passwords must be specified in
Setup (see the Configuration Guide).

When both Administrator and Operator passwords have been specified, the access

levels are as follows:

Access level Privileges and password requirements

Administrator Has full access to all Command WorkStation and Command
WorkStation LE functions, as well as Fiery EX2101 Control Panel
function. Administrator password required. For a description of the full
range of tasks an administrator can implement, see the Configuration
Guide.

Operator Has access to all Command WorkStation functions, except Setup, font
management, reordering job priority, restarting the Fiery EX2101,
clearing the Fiery EX2101 hard disk drive, and clearing the Job Log.
Operator password required.

Guest Can view job status, but cannot make changes to jobs or Setup, and
cannot access the Job Log; no password required.

Note: In Command WorkStation, a user can be logged in as Administrator on one
Fiery EX2101, as Operator on a second Fiery EX2101, and as Guest on a third
Fiery EX2101. In these instances, the levels of access are dependent either on the
Fiery EX2101 currently selected in the Active Jobs window or on the Fiery EX2101
that holds the currently selected job.

By default, no passwords are set on the Fiery EX2101—in this default state, anyone
can perform Setup and use all Command WorkStation and Command WorkStation
LE functions. Until an Administrator password is defined in Fiery EX2101 Setup, you
can log in to the Fiery EX2101 as Administrator without entering a password and are
given full privileges.

After the administrator has performed Setup and specified passwords, Command
WorkStation and Command WorkStation LE user options depend on your login level.
This manual assumes that you are logged in to the Fiery EX2101 as Operator.
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Logging out
Logging out from the Fiery EX2101 terminates the connection between the
Fiery EX2101 and Command WorkStation or Command WorkStation LE.

TO LOG OUT FROM A CONNECTED FIERY EX2101

1.

2.

Choose Log in/Log out from the Server menu.
Click the Login button for the connected Fiery EX2101 in the server list.
In Command WorkStation, click Yes to log out from and disconnect the Fiery EX2101.

Removing the Fiery EX2101 from the server list

You can clear unused Fiery EX2101 servers from the server list.

To REMOVE THE FIERY EX2101 FROM THE SERVER LIST

1.

2.

Choose Log in/Log out from the Server menu.
Select the Fiery EX2101 in the server list.

Click the Remove button (trash can icon in Command WorkStation LE) to remove the
Fiery EX2101 from the list.

The Remove button is available only for disconnected Fiery EX2101 servers.

Monitoring jobs

The Active Jobs window and the Printed Jobs panel of the Jobs window provide a
visual means of monitoring the flow of print jobs through connected servers. In
Command WorkStation, you can use the server selection menu in the title bar of
each window to monitor a single Fiery EX2101 or multiple Fiery EX2101 servers
(see page 2-12). You can also sort job lists and customize the job ticket information

that is displayed.

The Active Jobs window displays jobs as they pass through the various stages of
spooling, holding, processing, and printing. Flag colors indicate the status of each job,
and job ticket columns provide additional job information. Jobs that contain raster
data as a result of processing are marked with a halo around their file icons.
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NoTe: When you pause a job during printing (by issuing the Suspend Printing
command), the job continues to be marked with a dark green status flag in the Active
Jobs window. However, the job is displayed as “Paused.”

When a job has completed printing (or has failed to print), it drops from the Active
Jobs window and is added to the Printed Jobs panel. The Printed Jobs panel displays
jobs that have printed successfully, along with failed jobs that have dropped from the
print queue as a result of an error. A failed job appears highlighted in red. You can
double-click the job to display a more detailed error report.

Selecting jobs

Selecting a job allows you to apply job management commands (from the Actions
menu) to it.

TO SELECT A JOB

In the Active Jobs window or in any panel of the Jobs window, click a job to select it.

To select multiple jobs in Command WorkStation LE, hold down Shift and click
additional jobs.

Note: To select multiple jobs, the jobs must be located in the same window and panel.

Sorting job displays

You can sort jobs in the Active Jobs or Jobs windows by clicking the job ticket
column headings.

To SORT JOBS

In the Active Jobs or Jobs windows, click the heading for the job ticket column that
you want to use to sort jobs.

For example, to sort jobs by status, click the Job Status column heading. The window
sorts jobs according to their status.

To reverse the sorting order, click the column heading again.
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Customizing job ticket information

You can customize the display of job ticket information in the Active Jobs window and
in all panels of the Jobs window by rearranging the column headings. You can tighten
the columns, add new column headings, move columns, and delete column headings.

Job Status | Job Title | |ser | Dake/ Time | opies | Size

You can customize job ticket information according to your workflow needs. For
example, if you are monitoring multiple servers, you can add Fiery and Device
columns to track the Fiery EX2101 location of individual jobs.

In Command WorkStation, the information in the Date/Time column is based on
the date and time settings of the Regional Settings control panel. You can access the
Regional Settings control panel from the Start> Settings>Control Panel menu or
Start> Control Panel menu (Windows XP and Server 2003 only) in the Windows
taskbar.

TO CUSTOMIZE JOB TICKET INFORMATION FOR THE ACTIVE JOBS
OR JOBS WINDOWS IN COMMAND WORKSTATION*

1.

2.

Right-click the heading of a job ticket column.
From the menu that appears, choose the options to display and the sequence in which
you want to view them.

Add—Adds one of the listed columns to the display at your mouse position. The
submenu lists the headings that are not displayed.

Move Left, Move Right—Moves the selected column left or right.

Delete—Removes the selected column.

The Job Status (Active Jobs window only), Job Title, and User columns are required—
all others are optional.

Adjust the column widths.

Adjust the width of a column by clicking the column border in the heading and
dragging left or right. You can change the column widths at any time.
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TO CUSTOMIZE JOB TICKET INFORMATION FOR THE ACTIVE JOBS
OR JOBS WINDOWS IN COMMAND WORKSTATION LET

1. Control-click the heading of a job ticket column.
2. Choose Edit Visible Columns from the menu that appears.

3. In the List Editor dialog box, specify the job ticket columns that you want displayed.

To add a column, select the column name in the list on the right and click Add. To
remove a column, select the column name in the list on the left and click Remove.

8OC List Editor
Job Status << Add Archive Path
Job Title Colata
User Create Master
Data/Time Destination
Copies Davice
Size Document Server

Document Server Fila Nai
Duplex

EFBindingMarginWd
EFBooklstCanterMargin
Group Name

Input Tray [
Instructions b

méu-r 'Hi»"
( canca ) [0k )

4. Click OK to apply your changes.

5. Adjust the placement of columns.

Rearrange the placement of a column by dragging the column left or right.

6. Adjust the column widths.

Adjust the width of a column by clicking the column border in the heading and
dragging left or right. You can change the column widths at any time.



3-10 | Using Command WorkStation or Command WorkStation LE

Managing job flow

The following sections describe the job management tasks you can perform with
Command WorkStation and Command WorkStation LE.

Importing jobs

Use the Import command to import jobs into the job flow. You can import jobs
located anywhere in the connected network, or jobs previously archived to

external devices.

For information on archiving jobs, see page 3-30.

TO IMPORT A

1.

JOB INTO COMMAND WORKSTATION*

Choose Import from the File menu, and then choose Job or Archived Job.

The Select Files to Import dialog box appears.

Locate and select the job file to import and click Add.

The job appears in the Files to be imported list. To import multiple jobs, select each
additional job and click Add.

Choose the desired destination queue from the Logical Printer menu.

A destination queue is available only if the administrator has enabled it in Setup (see
the Configuration Guide).

If you choose Hold, the job is imported into the Active Jobs window and held for

future action.

If you choose Print, the job is imported into the Active Jobs window and released for
immediate printing.
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If you choose Direct, the job is sent directly to the Fiery EX2101 for printing. The job
does not appear in the Active Jobs window or Printed Jobs panel.

|”D aily Mews Report pdf"

Filename:

File of type: IAI\ Known Formats j Cancel

Files to be imported:

DM obshaudit Background. pdf m
Hemove
[ ptins.
Lagical Printer: I j Import

4. Click Import.

To IMPORT A JOB INTO COMMAND WORKSTATION LE¥

1. Choose Import from the File menu, and then choose Job or Archived Job.

2. Locate and select the job file to import and click Open.

8eoe Open: CWS LE
From: ( [@E Desktop ﬁ
[@E Desktop P B Archive
[ Documents » | T8 Archiveadd
(@ Library » T8 EditColumns
[ Movies r | T8 ImportDialog
@ Music » | T8 ImportOptions
(@ Pictures r B JobProp
@ Public » | T8 LElobProp
[ sites »| [ osx 3
Gota: |
Add to Favorites { Open
Y
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3. If the Import Options dialog box appears, specify the desired destination queue and

click OK.
800 Import Options
Import Options
[ Aero hold H
[ Atways show this dialog
]

You can control the display of the Import Options dialog box by specifying the
“Always show this dialog” option or setting the Show Import Options Dialog
preference (see page 2-28).

A destination queue is available only if the administrator enabled it in Setup (see the
Configuration Guide).

If you choose Hold, the job is imported into the Active Jobs window and held for

future action.

If you choose Print, the job is imported into the Active Jobs window and released for
immediate printing.

If you choose Direct, the job is sent directly to the Fiery EX2101 for printing. The job
does not appear in the Active Jobs window or Printed Jobs panel.

Using job management commands

As the operator, you can issue the following job management commands from the
Actions menu to release or hold selected jobs in the Active Jobs window and Printed
Jobs panel:

e Print

¢ Process and Hold

¢ Print and Hold

* Remove Raster Data

e Hold
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The availability of each command varies, depending on the context of the selected job.

In addition to choosing these commands from the Actions menu, you can issue them

from context-sensitive menus. Activate the Print, Hold, and Process and Hold

commands using the Action buttons.

The following table describes job management commands in greater detail and

explains how each command affects the raster data associated with a job:

Choose this command

To do this

Raster data is

Print Prints the selected job in the Active Jobs Temporarily held on the Fiery EX2101 until
window, Printed Jobs panel, FreeForm the job completes printing.
panel, or Archive panel.

Hold Holds the selected job waiting to process in | If raster data is included with the job, held
the Active Jobs window, or the selected job on the Fiery EX2101 hard disk indefinitely.
in the Printed Jobs or Archive panel, and
marks the job with either the spooled/held
flag or the processed/held flag.

Process and Hold Processes the selected job in the Active Jobs | Held on the Fiery EX2101 hard disk
window, Printed Jobs panel, or Archive indefinitely.
panel, and holds a copy of the job. The
copied job is marked with the processed/
held flag.

Print and Hold Prints the selected job in the Active Jobs Held on the Fiery EX2101 hard disk

window, Printed Jobs panel, or Archive
panel, and holds a copy of the job. The
copied job is marked with the processed/
held flag.

indefinitely.

Remove Raster Data

Removes the raster data associated with the
selected processed/held job in the Active

Jobs window, or with the selected raster job
in the Printed Jobs or Archive panel. Leaves

the original PostScript or PCL data in place.

Deleted.
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Viewing and overriding print settings

When logged in as Operator, you can view, override the user print settings, and print
any held job in the Active Jobs window and the Printed Jobs panel. You can view and
override print settings of jobs in the FreeForm panel. You can view print settings, and
print jobs in the Archive panel.

Use the Job Properties dialog box to view the user Notes and Instructions fields

included with jobs.

Note: For PCL jobs, you can only change the settings for Notes and Copies.

To VIEW AND OVERRIDE PRINT SETTINGS

1.

To view and override print settings for a held job, select the job in the Active Jobs
window or Printed Jobs panel.

You can also select a job in the Archive or FreeForm panel to view print settings.

Choose Properties from the Actions menu.

The Job Properties dialog box appears. This dialog box displays all the job settings
encoded by the PostScript printer driver that can be decoded by the Fiery EX2101. If
you, as the operator, have not changed anything, these are the settings a user entered
before sending the job.

The Job Properties dialog box is virtually identical to the Fiery Printing tab of
the Fiery EX2101 printer driver. For more information on the features in the
Job Properties dialog box, see the online help included with the Fiery EX2101
printer driver.
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The user Instructions and Notes fields also appear in the Job Properties dialog box.

* Instructions fields are intended to be viewed and annotated by the operator, but
their contents are associated with the job and are deleted when the job is deleted
after printing.

* Notes fields can be viewed but not changed by the operator. Their contents are

transcribed to the Job Log just as the user sent them.

NoTE: Some print options available in the printer driver are not displayed in the Job
Properties dialog box. For information about specific print options and settings, and
where you set them, see Appendix A of the Printing Guide.

To override a setting, expand the blue bar for that print setting category and specify
the desired setting.

Note: To retain a copy of the job with its original settings, duplicate the job and

rename the duplicate before you change any settings.

Note: For some options, changing the setting requires that the job be reRIPped. These
options appear with an icon to the left of the option name.

Job Properties - Bighumg.pdl
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4. To print the current list of print settings on a local printer, click Print Properties.

5.

To apply the print setting overrides to the selected job, click OK.
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Reordering jobs*

If you are logged in to Command WorkStation as Administrator, you can reorder the

priority of jobs that are waiting to process or print.

To REORDER JOB PRIORITY

1. In Command WorkStation, choose Reorder Jobs from the Server menu.

Reorder Jobs 10l =|
Job .. | Jok Tite | User | Datermime
vyaiting testd pof hazima 302602003 3:29:42 2

.

| Move job up in priority
| Move job down in priority
| Move job to lowest priority

&

Waiting EditColumns podf pam 31252003 2:36:59 4 T i iob high .
Wiaiting testd pof hazima 32512003 2:36:55 ¢ Move job to highest priority
i
1
1

&

o | |

waiting to process
I

Done I Cancel

2. (Click the tab that corresponds to the jobs that you want to reorder.

You can only reorder jobs that are waiting to process.

3. Select the desired job in the list, and use the buttons on the right of the dialog box to
reorder the job’s priority.

4. Click Done when you are finished reordering the job priority.
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Managing jobs on multiple Fiery EX2101 servers*

Command WorkStation allows you to simultaneously connect to as many
Fiery EX2101 servers as your RAM resources allow. You can view and manage jobs
processed by multiple Fiery EX2101 servers from a single location and balance the job

load between servers of similar capabilities.

* If you connect to multiple servers from Command WorkStation, you can easily
switch between the All Servers view and the Selected Server view in the Active Jobs
window, Jobs window, and Activity Monitor. For more information, see
“Monitoring single or multiple Fiery EX2101 servers*” on page 2-12.

* With servers that support the feature, use the “Send to” command to transfer jobs
between servers.

For example, by viewing print jobs on all connected servers in the Active Jobs window,
you can monitor the print load on each Fiery EX2101 in your printing environment.

If one Fiery EX2101 has received a disproportionate number of jobs, you can balance
the load by transferring some of these jobs to another, less active Fiery EX2101.

TO TRANSFER

1.

2.

A JOB BETWEEN SERVERS

In the Active Jobs window, select any held job.

Choose Send To from the Actions menu, and select the Fiery EX2101 to which you want
to send the job.

Click Yes to confirm the transfer of the job.
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Canceling jobs

You may have to cancel a job after it has been routed for processing or printing. You
can cancel a selected job only while it is being processed or printed. You cannot cancel
a job that is waiting to be processed or printed.

* Canceling jobs during processing—While a job is processing in the Active Jobs
window, select the job and choose Cancel Processing from the Actions menu or
choose Cancel Job from the Fiery EX2101 Control Panel.

When the job is canceled, a Canceling message appears on the Fiery EX2101
Control Panel. The name of the canceled job is displayed in the Job Log.

* Canceling jobs during printing—While a job is printing in the Active Jobs window,
select the job and choose Cancel Printing from the Actions menu or choose Cancel
Job from the Fiery EX2101 Control Panel.

When the print job is canceled, a Canceling message appears on the Fiery EX2101
Control Panel. The name of the canceled job is displayed in the Job Log.

Note: Canceled jobs may be partially printed and include pages that are completely
blank.

* Canceling a job at the Control Panel—From the Fiery EX2101, the most direct way
to cancel a job is to press the top line selection button on the Fiery EX2101 Control
Panel while the job is processing or printing. For more information on the Control
Panel, see the Configuration Guide.

* Pausing all jobs on the Fiery EX2101—Choose Suspend Printing from the Server
menu to suspend the printing of all jobs on the Fiery EX2101. To continue printing
jobs, choose Resume Printing from the Server menu.



3-20 | Using Command WorkStation or Command WorkStation LE

Defining Mixed Media settings*

The Mixed Media feature allows you to define chapter divisions for a job, print ranges
of pages on different weights of media, or insert blank media between pages. For more
information, see the Printing Guide.

NoTEe: Inserted blank media between pages are not charged as printed pages.

To DEFINE MIXED MEDIA SPECIFICATIONS*

1. In Command WorkStation, select a spooled/held job in the Active Jobs window, and
choose Mixed Media Setup from the Actions menu.

The Mixed Media dialog box appears. This dialog box lists any previously defined
media settings and includes buttons for adding, modifying, and deleting settings.
S

- Chapter
Chapter Start

| Define Each Chaplcr s 4
Separate Finishing et

—*@ Defins Mixed Madia

Page Range Duplex |Document Default -
Media Color | Document Default - HMedia Type |Document Default -
Paper Source | Document Default -

sl | Wedfy | Fenove |
Selection List
Fage Range | Duples | MediaColor | MediaType | Paper Source
By o White M) AnteSalact

2. In the Page Range field, enter page numbers or page ranges that should be printed on
a distinct type of media.

Pages and page ranges can be entered as comma-separated values (for example:
3,9-14,18). You can insert blank pages by placing a caret symbol before a page
value (for example: 2,A7,9-16).
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10.

11.

Choose the desired duplexing option for the specified page range from the
Duplex menu.

Choose the desired color of media for the specified page range from the Media
Color menu.

Choose the desired media for the specified page range from the Media Type menu.

Choose the source tray containing the specified media type from the Paper
Source menu.

Click Add to add the media specification to the Selection List. To remove a mixed
media specification, select it and click Remove.

Define and add more mixed media specifications as necessary. Page ranges not specified
as mixed media print on the media defined by the Paper Source settings.

In the Chapter Start field, enter page numbers on which to start new chapter sections.

Enter page numbers as comma-separated values (for example: 4,9,17) to designate the
start of each new chapter. This feature forces each starting page to use a right-side page,

adding a preceding left-sided blank, if necessary.

Note: It is not necessary to enter the first page, and page numbers refer to the
numbering of the original document. If you use the Chapter Start feature, all media
specified in the Media Type menu per chapter must share the same dimensions (for

example: all Letter, all Tabloid, or all A4).

To apply finishing options to each chapter section created using the Chapter Start
feature (for example, stapling or sorting), select “Define Each Chapter As A Separate
Finishing Set.”

Click OK.

The Job Properties dialog box appears.

Click OK to close the Job Properties dialog box and apply the Mixed Media settings to
the job.
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Inserting tab media*

The Insert Tabs feature in Command WorkStation allows you to automatically insert
tab pages throughout a job. This feature offers templates you can customize for
various sizes and types of tab media stock. The tab placement settings apply to all
tab-specified jobs. Users can insert the tab text and override text attributes on a
per-job basis.

After the tabs have been inserted, they become part of the job. A document preview
window displays the entire job in thumbnails and lets you edit the text of selected tabs,
as well as drag tab pages to reorder them.

Before tab pages can be inserted into a job, the Command WorkStation administrator
must set up templates for the tab media and text attributes.

To SET UP INSERT TABS*

1.

2.

In Command WorkStation, choose Insert Tabs Setup from the Server menu.

The Insert Tabs Setup dialog box appears.

IngertTabs Setup x|

Tab Media Mames

Add... I
I difi.. |
[elete). |

()8 | Cancel |

Click Add to create a new template.

In the Create Tab Setting dialog box, enter tab settings and text attributes and assign a
name to this template.
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Create Tab Setting x|
Mame - &
I 36.00pt j
— Tab Settings Tab Oifset
Mumber of positions
E | o)
Document reading order
I Left-ta-right - l
Media Type =
[
IUncoated 81-105gsm 'l 732.00pt
Fage Height
— Test Attributes
Fant =4=-"
IHeretica-BoId 'l
Size
I‘ID 'l L/
o)
Text Offset Fage width
bs ID.DDpt Ay ID.DDpt b [eqgo0pt ——F—
Text Rotation L A A
In <z 36.00pt  ——4 |=]—
Tab Wwidth
()8 I Cancel |

In the Name field, enter a descriptive name for this template, up to 20 characters long.
In the Tab Settings area, use the menus to enter the following:

* Number of positions on the tab stock, from one to eight

* Document reading order, which is the order of the tab text, from right to left or

left to right

* Tray containing the tab media

In the Text Attributes fields, enter the following changes to the default tab printing,
if desired:

* Desired font type, selected from all fonts installed on the system, and font size,
from 6 to 12 points

o Text offset, which offsets the center of the text on the tab using x- and
y- coordinate values
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Note: Text is vertically and horizontally centered on the tab by default. Only positive
values may be entered for offset.

¢ Text Rotation, In or Out

Use Text Rotation In if the tabs appear across the top of the document; the text
prints left to right. (This is the most common use.) Use Text Rotation Out if the
tabs are to appear across the bottom of the document; the text prints so that it is

legible when the tab page is turned upside down.

On the right side of the Create Tab Setting dialog box, enter the following:

* Tab offset, which is the distance from the top of the page to the first tab edge
* Page height and width

¢ Tab width

3. Once you have entered the settings for the template, click OK.

Your new setting now appears in the Tab Media Names scroll box. When you finish
creating or modifying settings, click OK.

To MODIFY AN EXISTING TAB SETTING*

1. In the Insert Tabs Setup dialog box (see page 3-22), select the name of a predefined
setting you want to edit and click Modify.

2. In the Modify Tab Media dialog box, enter tab settings and text attributes, as
described on page 3-23.

Once the administrator configures the Insert Tabs settings, users can insert tab pages
into their jobs using Command WorkStation.
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TO INSERT TABS INTO A PRINT JOB*

1. Select a spooled/held job in the Active Jobs window, and choose Insert Tabs from the
Actions menu.

A dialog box may appear indicating that Command WorkStation must generate
thumbnails for this file. If this window appears, click Yes.

2. In the Insert Tabs dialog box, choose the desired template setting from the

Name menu.
Insert Tabs x|
Step 1
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3.

Make any necessary changes to the text attributes and click Next.

For descriptions of these options, see page 3-23.

Enter the number of tabs needed for this document and click Next.

Note: If the media tray is loaded with five-tab collated stock, but the print job calls for
fewer tabs, the stock for the unused tabs must be removed from the tray before the job
is printed.

For each tab, enter the page number that the tab page should follow, and enter the
text that should appear on that tab. When you have entered the page numbers and
text for all the tabs, click Finish.

The Insert Tabs dialog box appears, displaying a preview of your document in a linear
fashion, with thumbnail images representing document pages, including the inserted
tab pages. Make any necessary edits to the tab pages.

Ingert Tabs - Pamela. pdf x|

T -m2-

Inserted tab page within
the document preview

4 |

dd.. | Hede | Dl

As you review the document, reposition the tab pages by dragging and dropping their
respective thumbnails, or select a tab thumbnail and click Modify. This opens the Tab
Insert Info dialog box, which allows you to reorder that tab page numerically or edit
its text.

Clicking Delete deletes the tab that is highlighted.
Note: During duplex printing, if a tab page is inserted between Pages 3 and 4, the

inserted tab page is printed after Page 3 on the first sheet, and Page 4 is printed on the

next sheet.
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Printing FreeForm variable data documents

The FreeForm printing feature provides a flexible and efficient method of printing
variable data jobs, such as direct-mail advertising pieces. FreeForm allows users to
preRIP and store the master elements of their variable data jobs on the Fiery EX2101,
and then use that master data, as needed, for multiple variable data jobs.

Note: FreeForm is not available for PCL jobs.

The preRIPped master-element jobs are stored on the Fiery EX2101 as FreeForm
masters, and appear in the FreeForm panel of the Jobs window.

The ability to override job settings is especially important for variable data printing
with FreeForm. Although the Fiery EX2101 can store up to 100 FreeForm masters,
users are limited to a range of 1 to 15 values that they can specify for the Create Master
and Use Master print settings. To make use of all 100 available FreeForm Masters, the
operator must override the Create Master and Use Master print settings from
Command WorkStation or Command WorkStation LE.

Note: For any new Create Master or Use Master setting to take effect, the job must be
reRIPped.

For background information on using the FreeForm feature, see the Printing Guide.

Creating and monitoring FreeForm masters

Users can assign FreeForm master numbers from 1 to 15 using the Create Master print
option when they send a job. These numbers can be changed to a master number from
1 to 100, with job overrides from the Job Properties dialog box.

When the first 15 FreeForm master numbers have been used, users may inadvertently
overwrite existing FreeForm masters by assigning what they think are new, unused
FreeForm master numbers. When users choose a master number from the Create
Master print option, an existing job using that master number is overwritten (the user
receives a warning message that they are about to replace an existing job).
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For this reason, the operator should delete existing master jobs or reassign master
numbers 1 through 15 to avoid any overwriting problems. Only the Operator can
assign numbers from 16 to 100, enabling a high level of control over the FreeForm

master numbers in use.

To CREATE A FREEFORM MASTER

1. In the Active Jobs window, select the held job comprising the master elements of
the document.

2. Choose Properties from the Actions menu.
3. Scroll to FreeForm in the Job Properties dialog box.

4. For the Create Master print setting, specify the FreeForm master number you want to
assign to the job and click OK.

5. Choose Process and Hold from the Actions menu to assign the job a destination.

Choose Print, or Print and Hold from the Actions menu for a hard copy of the

FreeForm master.

After processing, the master job appears in the FreeForm panel of the Jobs window.

To DELETE A FREEFORM MASTER

1. In the FreeForm panel, select the master job to delete.

2. Choose Delete from the Actions menu.
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Using FreeForm masters with variable data jobs

To print a variable data job with a particular FreeForm master, users must specify a
number for the Use Master print setting. Users can only specify master numbers
between 1 and 15. Only the operator can specify master numbers between 16 and 100,
with job overrides from the Job Properties dialog box.

To OVERRIDE

1.

7.

THE USE MASTER PRINT SETTING

In the Active Jobs window, select the held job comprising the variable elements of the
document, and choose Properties from the Actions menu.

Scroll to FreeForm in the Job Properties dialog box.

For the Use Master print setting, specify the FreeForm master job to use as the master
document.

Click Update.

To display a preview of the specified master job, click Preview Master.

Click OK.

Choose Process and Hold, Print, or Print and Hold from the Actions menu to assign the

job a destination.

Particularly with a variable data job, Process and Hold the job so you can preview it
before printing.

Tips for using FreeForm

At sites where a small number of users print FreeForm jobs, the Operator may want to
assign FreeForm master numbers to specific users, then let them monitor their own
master numbers. Users can choose the Create Master print option to assign new
masters or overwrite existing masters. They can also instruct the Operator to reassign
master numbers (to a number greater than 15) for FreeForm masters they want
available on the Fiery EX2101.
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At sites where a large number of users print FreeForm jobs, the Operator may want to
instruct users not to use the Create Master print option at all, but rather to send all
their jobs to the Hold queue. In this case, the Operator can decide which FreeForm
master numbers to assign before printing.

For all jobs sent to the Fiery EX2101, users should specify information (such as the

desired FreeForm master number) to the operator using the Notes and Instructions
fields in the Printer Job Notes dialog box.

Note: When specifying additional print settings for FreeForm jobs, certain print
option settings must match for bozh the master and the variable job. Also, certain
settings in the variable job override corresponding settings in the master job. For
complete information on print settings in FreeForm jobs, see the Printing Guide.

Archiving jobs

You can archive PostScript and raster data jobs internally to the Fiery EX2101 hard
disk drive, or externally to the Command WorkStation or Command WorkStation LE
hard disk drive or network drives. Once a PostScript or raster data job is archived, it
appears in the Archive panel of the Jobs window.

You can issue the following Actions menu commands, described on page 2-14, for jobs
in the Archive panel:

e Print

¢ Delete

* Rename

* Hold

¢ Process and Hold

¢ Print and Hold

¢ Remove Raster Data

* Properties
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To ARCHIVE A JOB

1.

2.

In the Active Jobs window, select any held job.
Choose Archive from the Actions menu.

To archive the job internally to the Fiery EX2101 hard disk drive, click OK.
The job is archived internally and appears in the Archive panel of the Jobs window.

To archive the job externally to the Command WorkStation or Command WorkStation
LE hard disk drive or to a device on the network, click Add.

Archive Options E

Directories
Add .. '|
Click to add a device

[Velete |

= erctiveiasters

Cancel |

Browse to the device and folder to which you want to archive the job and click 0K
(Command WorkStation) or Choose (Command Workstation LE).

The Archive Options dialog box displays external devices as available archive volumes.
In Command WorkStation, if applicable, select Archive rasters in the Archive Options
dialog box.

The Archive rasters option is not available for PostScript data jobs and jobs archived to

Server Internal.

Note: Large raster data files may take considerable time to archive.

Select an archive volume and click OK.

Archived jobs appear in the Archive panel of the Jobs window.
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Using the Job Log

The Job Log panel of the Jobs window displays a list of all the jobs processed or printed
since the Job Log was last cleared.

You can adjust the column widths in the Job Log display by clicking the column
border in the heading and dragging left or right (see “Customizing job ticket
information” on page 3-8). You can also print the Job Log, export it to a tab-delimited
text file, or clear it manually.

Using the Job Log Setup, the administrator can specify preferences to print the Job Log
automatically every 55 jobs, or print and clear the Job Log automatically every 55 jobs.
Periodically clearing the Job Log helps improve the performance of the Fiery EX2101.
The administrator can also choose the Job Log page size. For more information, see the

Configuration Guide.

Note: If a job was saved from the Imposition window of DocBuilder Pro with a new
name and then printed, it appears in the Job Log with the name of the original job, nor
the new name.

||| Job Log

Frint Status | Jab Title User DatelTime Size [~
[s]%¢ [ hittp:ifwenee raman... Pat 312003 5:18:20 PM 311 KB
[s]%¢ [ hittp:ifwenee raman... Pat 3200351752 PM 256 KB —
[s]%¢ [ hittp:ifwenee raman... Pat 320351721 PM 253 KB
[s]%¢ [ hittp:ifwenee raman... Pat 312003 5:16:37 PM 343 KB
[s]%¢ [ Dsfinaloutput? pdf Leslie 312003 4:51:43 PM 4573 KB
o]'4 [4 start Page Operator 312103 44311 PM 1201 KB
o]'4 [4 start Page Operator 31203 41525 PM 1201 KB
o]'4 [ Online Membership... sam 3112103 4:05:06 PM 46 KB
o]'4 [4 start Page Operator 312103 4:03:35 PM 1201 KB =
.|
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To PRINT THE JOB L0OG FROM COMMAND WORKSTATION ON A
LOCAL PRINTER*

1. In Command WorkStation, choose Print from the File menu, and then choose Job Log.

The Print dialog box appears.

2. Specify your local printer settings and click OK.

TOo EXPORT THE JoB L0G

1. If it is not already displayed, click the Job Log tab on the Jobs window to open the
Job Log panel.

2. Click inside the Job Log panel to make it active.

3. In Command WorkStation, choose Job Log from the Server menu, and then choose
Export. In Command WorkStation LE, choose Export from the File menu, and then
choose Job Log.

4. Rename the file, if desired (the default name is job.log), specify a destination, and
then click Save.

The Job Log is exported to a tab-delimited text file. You can open the exported file
using a spreadsheet, database, or word processing application.

TO CLEAR THE JOB L0G

e In Command WorkStation, choose Job Log from the Server menu and then choose
Export and Clear. In Command WorkStation LE, choose Clear Job Log from the Server
menu.

NoTE: You can clear the job log only if you are logged in to the Fiery EX2101 with
Administrator privileges.
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Searching for jobs

The Find command allows you to search for and locate jobs on connected servers,
using search parameters, such as job file names or dates of creation. Use the Find
command to search for jobs that appear in the Active Jobs window and in the Printed
Jobs, Archive, FreeForm, and Job Log panels of the Jobs window.

In Command WorkStation, you can also perform advanced searches based on the file
sizes and specific print options associated with jobs. You can save any set of general or
advanced search parameters as a Find template, which you can reuse to perform the
search again.

TOo SEARCH FOR JOBS

1.

Choose Find from the Edit menu.

The Find dialog box appears.

In Command WorkStation, choose a specific Fiery EX2101, or all Fiery EX2101 servers
from the Search Server list.

Select one or more areas where you want to search for jobs.

You can search for jobs in the Active Jobs window and in the Printed Jobs, Archive,

FreeForm, and Job Log panels of the Jobs window.

Click the General tab, and specify parameters for the search.

NoTe: To clear all fields in the Find dialog box at any time, click New Search
(Command WorkStation) or New Find (Command WorkStation LE).

You can specify any or all of the following general search parameters. Available search
parameters vary, depending on the areas selected for the search.

Job title—Enter the file name of the job.

User—Enter the name of the user who sent the job.

Notes 1, Notes 2—Enter text that appears in the Notes fields of the job.
Instructions—Enter text that appears in the Instructions field of the job.

Volume*—Specify the archive drive volume you want to search. This option is
available only when you are searching for archived jobs.
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Date created*—To search through all jobs, regardless of their creation date, select All.
To restrict your search to jobs created on a certain date or range of dates, select Range.
Use the From and To menus to specify start and end dates.

5. Click Search (Command WorkStation) or Find (Command WorkStation LE) to find jobs
that meet the specified search criteria.

The Search Results window (Command WorkStation) or Find dialog box (Command
WorkStation LE) lists found jobs.

In Command WorkStation, you can customize the appearance of the Search Results
window in the same manner as the Active Jobs and Jobs windows. For example, you
can display jobs on all connected Fiery EX2101 servers or on a selected Fiery EX2101
(see page 2-12), and you can customize the job ticket information (see page 3-8).

In Command WorkStation LE, you can customize the display of found jobs by resizing
or rearranging the job ticket columns (see page 3-9).

To PERFORM AN ADVANCED SEARCH FOR JOBS*

Note: The Advanced search feature is available for Command WorkStation only.

1. Choose Find from the Edit menu.
The Find dialog box appears.
2. Choose an option from the Search Server menu to search for jobs on a specific
Fiery EX2101 or all connected Fiery EX2101 servers.
3. Select one or more areas to search for jobs.
Search for jobs in the Active Jobs window and in the Printed Jobs, Archive, FreeForm,
and Job Log panels of the Jobs window.
4. Click the Advanced tab.

The Advanced tab of the Find dialog box includes an area for specifying file size search
parameters. The Advanced tab also contains a list of all the print options associated
with jobs on the server or servers specified by the Search Server setting.

To search for jobs that fall within a particular range of file sizes, choose a range option
from the Size (kilobytes) menu. Enter the range values in one or both of the fields.

To search for jobs that have certain print options, click the selection box for each
desired print option in the list.
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To specify additional search values for a selected option, right-click the field next to the
option name and enter the desired values.

If you select multiple print options, Command WorkStation searches for jobs that
include a// the selected options. For example, if you specify a stapling and a punching
option for your search, Command WorkStation only finds jobs that have both stapling
and punching specified.

Note: To clear all fields in the Find dialog box at any time, click New Search.

Click Search to find the jobs that meet the specified search criteria.

The Search Results window lists the found jobs.

TO SAVE THE CURRENT SET OF SEARCH PARAMETERS AS
A FIND TEMPLATE

1.

In the Find dialog box, specify the desired search parameters, as described in previous
procedures.

Click Save As.

A dialog box prompts you to name the template.

Enter a name for the new Find template and click OK.

Saved templates appear in the Queries menu. To remove a template from the menu,
select the template and click Delete.

In Command WorkStation, saved templates are stored in the folder location you
specified in the Preferences dialog box (see page 2-27).

To REUSE A FIND TEMPLATE

1.

In the Find dialog box, choose the desired template from the Queries menu.
The dialog box is automatically populated by the search parameters associated with the

template.

Click Search (Command WorkStation) or Find (Command WorkStation LE) to begin
searching for jobs.
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Chapter 4:
Previewing and
Manipulating

Jobs

The Preview windows of Command WorkStation and Command WorkStation LE
allow you to display preview images of jobs and perform edits, such as adding,
deleting, duplicating, and reordering pages. You can also merge pages from two
different jobs into a single, merged job.

Note: The viewing, editing, and merging features of the Preview windows are not
available for PCL files or any job sent with the PCL printer driver.

Note: DocBuilder Pro allows you to use additional preview and edit features. For more
information, see page 5-1.

Note: Unless otherwise specified, information in this chapter applies to both
Command WorkStation and Command WorkStation LE. In cases where the two
applications are nearly identical, only Command WorkStation illustrations are shown.

Previewing jobs

Use the Preview windows to preview pages of selected jobs.

Note: The thumbnail and full-screen previews in the Preview window are not
designed to display color accurately. Do not use the Preview window to soft-proof
colors in a job.

Displaying thumbnail previews

When you select a job and choose Preview from the Actions menu, a preview window
opens, displaying thumbnail images of the selected job.

To VIEW THUMBNAILS OF A JOB

1.

In Command WorkStation, select a processed/held job in the Active Jobs window, or
select a FreeForm master job in the FreeForm panel. In Command WorkStation LE,
select a spooled/held or processed/held job in the Active Jobs window.

Choose Preview from the Actions menu.

Page thumbnails appear in the Preview window.
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Preview window controls

The following illustrations show the various controls (represented by icons) that are
available in the Preview window. Each control is described in more detail in other

sections of this chapter.

Command WorkStation

#. Preview - BigNums.doc

Full-screen Preview Undo
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Duplicate l 2 3
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Command WorkStation LE
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Displaying full-screen previews

You can open a selected page in the Preview window as a full-screen image for a more
detailed inspection.

Note: Full-screen previews are not supported for FreeForm jobs.

To VIEW A

FULL-SCREEN PREVIEW OF A JOB

Select a page in the Preview window and click the Full-Screen Preview control
(see page 4-2).

Note: The full-screen preview may take a few moments to open. The full-screen
preview window is independent of Command WorkStation or Command
WorkStation LE and may appear behind the application on the screen. Bring the
full-screen preview window to the front, if necessary.

Command WorkStation

4. Preview - BigNums.doc [_ O] =]

Thumbnail

Previous Page

Next Page

Rotate (90, 180, or 270
degrees)
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Command WorkStation LE

Scroll bar (to view other pages)

8086 Preview: TabStock-MM
NN B g L ] -|w-|‘|-\‘|-\‘
Thumbnail ? 2
Zoom In } o &
1
Zoom Out

Next Page

Rotate (90, 180, or 270 degrees)

Previous Page

Use the controls (represented by icons) in the full-screen preview to change the zoom
level, rotate the page, display other pages, or return to the thumbnail preview.
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Editing and merging jobs

Use the Preview windows to reorder and edit the pages of a job, or merge pages from
several jobs into a single job.

Editing jobs

The Preview window includes controls that allow you to make page-level edits to a job.

To EDIT A JOB

1. In Command WorkStation, select a processed/held job in the Active Jobs window,
or select a FreeForm master job in the FreeForm panel. In Command WorkStation LE,
select a spooled/held or processed/held job in the Active Jobs window.

The Preview window opens, displaying thumbnails of the pages in the job.

2. Select the pages you want to edit.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) or
Command-click (Command WorkStation LE) to select multiple, non-sequential

pages.
3. Apply the desired edits.

To apply edits to the selected page, click any of the controls that appear under the title
bar of the Preview window (for an illustration, see page 4-2):

Full-Screen Preview—Opens a full-screen preview of the selected page (see page 4-3).
The full-screen preview allows you to rotate the selected page.

Duplicate—Duplicates the selected page.
Delete—Deletes the currently selected page.
Undo—Reverses recently performed edits.

Redo—Reapplies recently performed edits. This control is available for Command
WorkStation only.
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4. To move pages within the Preview window, click to select the pages, and hold down the
mouse button as you drag the selected pages to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) or
Command-click (Command WorkStation LE) to select multiple, non-sequential
pages. Release the Shift, Command, or Cttl key before moving the pages. If you move
the pages on top of existing pages, the pages are overwritten.

In Command WorkStation LE, a blue vertical line indicates the destined location of
the page you are dragging.

In Command WorkStation, the following icons indicate the result of your action. If
the icon does not have an arrow, existing pages are overwritten and replaced by dragged
pages; if the icon has an arrow, the dragged pages are inserted.

Replace single page Replace multiple pages

%

\Z

Move single page Move multiple pages
between two pages between two pages
< <«

Move single page Move multiple pages
before first page before first page
> >
Move single page Move multiple pages
after last page after last page

5. When you finish making edits, click the Save control (see page 4-2) to save the job.

6. Enter a new name for the editing job and click Yes (Command WorkStation) or Save
(Command WorkStation LE).
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Merging jobs

Merging allows you to combine documents from different sources into a single file. For
example, you can combine covers and chapter head pages created in a page layout
application with text pages created in a word processing application. Or, you can
customize a slide presentation by inserting slides from a different presentation.

Note: When printing a merged job, Command WorkStation or Command
WorkStation LE generally gives priority to the print settings of the original jobs over
those of the merged job. Before merging two jobs, make sure that both jobs have been
processed using the common print settings desired for final output. For example, to
create a merged job that prints to duplexed pages, make sure both original jobs have
been processed with the duplex setting enabled. Overriding the print settings of a
merged job can produce unexpected results and is not recommended.

TOo MERGE PAGES FROM TWO DIFFERENT JOBS
1. Select a job and choose Preview from the Actions menu.
2. Select another job and choose Preview from the Actions menu.
The job is displayed in another Preview window.

Note: To merge pages, both jobs must reside on the same Fiery EX2101.
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#. Preview - BiglLetts doc

Source document preview

Destination document preview

3.

-01- 02|
1 | »

In the source document Preview window, click to select the pages, and hold down the
mouse button as you drag the selected pages to the new location in the destination
document Preview window.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) or
Command-click (Command WorkStation LE) to select multiple, non-sequential
pages. Release the Shift, Command, or Ctrl key before moving the pages.

To replace pages, drag the second preview pages on top of pages in the first Preview
window; to add pages, drag the pages to a new position between pages, before the first
page, or after the last page in the first Preview window.

Moving the selection over an existing page replaces the existing page with the one you
are moving. Moving the selection to the left or right of a page places the selection in
that location and renumbers the pages.



4-9 | Editing and merging jobs

4.,

In Command WorkStation LE, a blue vertical line indicates the destined location of
the selection you are dragging. In Command WorkStation, the cursor changes to
reflect the result of your action:

Replace single page Replace multiple pages

\Z \Z

Move single page
between two pages

é

Move single page
before first page

Move multiple pages
between two pages

é

Move multiple pages
before first page

9

>
Move single page Move multiple pages
after last page after last page

Multiple levels of undo are available; use the Undo control to undo all the way back to
your first edit. There is a Redo control.

NoTe: After you drag pages from one Preview window to the other, the first window is
designated as the source, and the other window the destination. During a merging
session, you can drag pages only from the source window to the destination window,
not vice versa. To merge pages in the opposite direction, you must save your current
changes to the destination window and begin a new merging session.

To merge additional pages from another source job, open a new job (resident on the
same Fiery EX2101) in a Preview window.

Repeat step 3 to merge pages from the new source job.
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5.

When you have finished merging pages, click the Save control (see page 4-2).

Enter a new name for the merged job, and click Yes (Command WorkStation) or Save
(Command WorkStation LE).

Note: When multiple users are connected to the Fiery EX2101 via a job management
utility, only one user should make changes at a time. If multiple users make changes in
the same job simultaneously, unexpected results may occur.
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The DocBuilder Pro option allows you to apply imposition layouts to jobs for special
printing and binding needs. DocBuilder Pro also provides several enhancements to the
previewing, editing, and merging features of Command WorkStation.

For background information on using imposition, see Appendix A. For information on
customizing imposition settings, see Chapter 6.

Note: DocBuilder Pro is available as an optional upgrade for Command WorkStation.

For more information, contact your authorized service/support technician.

Previewing, editing, and merging jobs

With the DocBuilder Pro option, you can use the Preview windows of Command
WorkStation to preview, edit, and merge PostScript and PDF jobs that have been
spooled and held. You can apply all of the features discussed in Chapter 4 to
spooled/held jobs and processed/held jobs.

Detailed descriptions of the DocBuilder Pro enhancements to the Preview windows
follow. When applicable, page number references to sections in other chapters are

provided.

Previewing jobs—You can select any PostScript or PDF job showing a spooled/held
(light yellow) status, and open the job in a Preview window (see page 4-1).

When you preview a PostScript job, Adobe Acrobat automatically opens in the
background, generating PDF thumbnails that allow you to preview the job and
perform further edits, including merging. A message prompts you to accept conversion

of the file to PDE
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When you open the full-screen preview for a spooled/held PostScript or PDF job, you
have access to three additional preview controls, as shown in the following illustration.

4. Preview - Bighums. pdf [_ O] =]

Move preview around in window F"T| ,T“T“f‘ M‘“T‘

Magnify preview
(hold down Ctrl to zoom out)

Click to edit page content

1] | o

Editing page content—Edit the contents of a spooled/held page by opening its full-
screen preview (see page 4-3), and using the Adobe Acrobat and Enfocus PitStop
editing tools (see page 6-21).

Merging jobs—You can merge pages from several spooled/held jobs together in a new
file (see page 4-7). To merge jobs, both jobs must have the same status; that is, both
jobs must be spooled/held or processed/held.

Inserting blank pages—You can insert blank pages into a spooled/held PostScript or
PDF job. First, open the job in a Preview window. Right-click a page thumbnail, and
choose Blank Page from the menu. A blank page is inserted after the currently
selected page.



5-3 | Imposition window

Imposition window

From the Imposition window, you can impose the pages of a document in an order
and positioning suitable for printing and binding. If you are connected to more than

one server at once, you can access the Imposition feature from one server only.

Note: The imposition feature is not supported for PCL jobs.

To OPEN A JOB IN THE IMPOSITION WINDOW

1.

Send the desired job to the Hold queue.

For information on using Command WorkStation, see Chapters 2 and 3.

Select the spooled/held job in the Active Jobs window, and choose Impose from the
Actions menu. You can also right-click the job and choose Impose from the menu that
appears.

You can open a PostScript or PDF (Portable Document Format) file, but it must show
a spooled/held job status.

Note: If you have installed the DocBuilder Pro option, you must install a dongle on
your workstation. If the dongle is not attached, an error message appears. For more
information, contact your authorized service/support technician.

To impose a processed/held job, select the job in the Active Jobs window and choose
Remove Raster Data from the Actions menu to put the job in a spooled/held status.
Then choose Impose from the Actions menu. To impose a printed job, select the job in
the Printed Jobs window and choose Hold from the Actions menu.
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When you choose the Impose command, a page-imaging process generates a PDF
version of the job on which DocBuilder Pro performs imposition.

A status window appears while the job is imaged for the Imposition window.

Prepare selected job for imposition. .. |

Imposition - Print Brochure. pdf

28%

When it opens, the Imposition window displays the job. No layout is applied unless
the job has been previously imposed. Templates for common layouts are provided and
can be invoked from the Imposition window, as described in “Using templates” on
page 5-11.
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Job previews

The Imposition window provides a preview of a job’s pages, allowing you to
manipulate the source PDE

Pages appear as a printer’s spread; that is, they appear in the order in which they are
printed as an imposed job. In contrast, a reader’s spread shows pages in the order they
are intended to be read. Note that the Preview windows in Command WorkStation
image jobs as reader’s spreads.

! S BLY el
dr| =

Printer’s spread

3

-03- -04-

-01-

Reader’s spread

The paper used to print a printer’s spread is known as a sheet. In duplex printing, each
sheet has two imageable surfaces—one on the front side and one on the back side of
the sheet. Each imageable surface contains one printer’s spread.
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Navigating in the Imposition window

Use the icons and menus at the top and bottom of the Imposition window to perform
the following:

o Switch from Preview mode (thumbnails of actual content) to Layout mode (page
numbers only).

* Switch between Mixed Page mode (document with varying page sizes) and Fixed
Page mode (document with a single page size). For more information on Mixed Page
and Fixed Page modes, see page 6-1.

* Zoom in and out.
* Drag the job preview around to make a particular page or sheet surface visible.

* Go directly to a particular page or sheet surface.

The Zoom tool, Pan tool, Preview mode, Layout mode, Mixed Page mode, and Fixed
Page mode buttons are located in the upper-right corner of the window.

Fixed Page mode

Mixed Page mode

Pan tool

Zoom tool

Layout mode

Preview mode

Layaut

Scale

Finishing Suface1of8 | Fit Page 4] | |
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Selecting the Pan or Zoom tool changes the appearance of the cursor to indicate you
can use that tool to manipulate the preview. When you choose Preview, Layout, Mixed
Page, or Fixed Page mode, a blue border appears around the selected view, and the
appearance of the job in the Imposition window changes immediately.

Imposition settings appear grouped in the Sheet, Layout, Scale, and Finishing panes at
the left of the window. To expand or collapse a pane of settings, click the bar for that
pane.

The Surface menu, View menu, and scroll bar appear at the bottom of the window.
These menus and controls affect the display in the Imposition window immediately.

Switching between page view and layout view

Use the view mode buttons to switch between a page view and a layout view of the job.

* Preview mode—approximates the appearance of the final printed output very
closely; for this reason, it is sometimes called a WYSIWYG (“what you see is what

you get”) preview.

* Layout mode—displays numbered, generic pages that allow you to determine the
location of source document pages in the imposed job. You can rotate individual
pages in a layout view.

Different viewing modes may display different sets of printer’s marks. For more
information, see the following table.

NoTE: Preview mode puts more stress on your system’s processor than Layout mode. To
improve performance on slower systems, perform most of your work in Layout mode,

switching to Preview mode only when you must see content.

In Layout mode, you can rotate individual pages on the sheet. For more information,
see “Rotating pages” on page 6-22.
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The following table summarizes the characteristics of the Layout and Preview modes:

Feature Layout mode Preview mode

Shows page content No WYSIWYG content view
Quick redraw on Yes No

slower computers

Shows printer’s marks Yes Yes
Enable/disable printer’s marks Yes Yes

Reorder pages Yes No

Rotate pages Yes No

Define gutter Yes No

Setting magnification levels

Use the Zoom tool to increase or decrease the level of magnification in the Imposition
window from 12% to 800%.

The View menu at the bottom of the window provides several ways to set the level of
magnification to display the contents of the window. The View menu allows you to
choose preset zoom values ranging from 50% to 800%. You can also choose to make
the current preview fit in the window. In addition to preset zoom percents, you can

specify a custom zoom value.
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TOo USE THE Z0OM TOOL

1.

Click the Zoom tool to select it.

Zoom tool

The cursor changes to a magnifying glass in the preview area of the Imposition
window.

Position the magnifying glass cursor over a page and click to zoom in.

The magnifying glass cursor displays a plus sign (+) to indicate increased magnification
of page views. Each time you click, the current magnification doubles, up to a
maximum of 800%.

Hold the Ctrl key and click to zoom out.

Each time you click, the current magnification is reduced in half, down to a minimum
of 12%.

Right-click the page in the Imposition window.

Select Zoom In or Zoom Out from the menu that appears. Zoom In doubles the
current magnification, and Zoom Out reduces the current magnification by half.

To USE THE VIEW MENU

Click the View menu and choose a zoom percent.

To preview the entire surface, click the View menu and choose Fit Page.

Note: The View menu changes only the appearance of pages, not their actual content.
To change the scaling of pages in finished output, change the Scale area settings.
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TO SPECIFY A CUSTOM ZOOM VALUE

1.

Click the View menu at the bottom of the Imposition window.

The current zoom value appears in the Zoom dialog box.

Specify a new zoom value.

Enter a new zoom value or select a value from the menu.

Click OK or press Enter to confirm the new value.

The window reflects the change immediately.

Viewing the sheets

Use the Pan tool to drag the entire preview around in the window. For example, if you
are working with many pages on a large sheet, you can use this tool to drag a particular

portion of the sheet into view.

At the bottom of the window, you can manipulate the content view using a standard
scroll bar or the Surface menu. The Surface menu opens the Go To Surface dialog box,
which allows you to specify numerically the surface to display in the preview area.

To USE THE PAN TOOL

1.

Click the Pan tool to select it.

Pan tool

The cursor changes to a hand in the Preview area of the window.
With the Pan tool cursor positioned over a sheet, click and hold the left mouse button
while moving the mouse.

The page preview moves in the same direction as the cursor. Repeat this step as

necessary to make a particular portion of the preview visible.
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TO USE THE SURFACE MENU

1.

Click the Surface menu at the bottom of the window.

When the Go To Surface dialog box appears, the Surface field indicates the number of
the sheet surface currently displayed.

Go To Surface E
Surface: I of B

()8 I Cancel |

Enter the number of the sheet surface to display.

Click OK or press Enter to go to the specified sheet surface.

Using templates

A saved group of imposition settings is known as a template. A template saves all
current imposition settings, except custom rotations of individual pages on a finished
sheet and the page size setting. You can apply any template to any job, making it easy
to apply layout and printing settings quickly and efficiently.

DocBuilder Pro supplies built-in templates that define settings for commonly used
layouts, such as 2-Up Saddle, 3-Up Trifold Brochure, 4-Up Gatefold, and so on. You
can also create your own templates. For a complete listing of built-in templates, see
Appendix B. For information on creating your own templates, see “Managing
templates” on page 6-24.

Both built-in templates and your own custom templates appear in the Template menu.
You can apply a template by choosing its name from the Template menu, in the upper-
left corner of the Imposition window. The new settings take effect immediately.

Save template

: Imposition - BigLetts. pdf

Name of current template

Delete template
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Saving your work

It is important that you save the work you perform using the tools in the Imposition

window.

TO SAVE THE

1.

IMPOSED JOB

Click the Close box in the upper-right corner of the Imposition window.

Close box

If the job has changed since it was opened in the Imposition window, you are
prompted to save it.

In the Save As dialog box, type a name for the job and its settings.

Save As E

The job haz been changed. Do you want to save it?

0ld name: BiglLetts. pdf

Mews name: IBigLetts.pdf.dbp

es Mo Cancel

Click Yes.

In the Save As dialog box, the name of the original spooled source file appears with a
new extension (.dbp). If you mistakenly close the Imposition window when you intend
to keep working, click Cancel in the Save As dialog box. The original PostScript or
PDF file remains intact, even after the converted file has been edited and saved in the
Imposition window.

Note: When you rename an imposed file, you must include the .dbp extension. The
extension is required to reopen the file with DocBuilder Pro.

For more information on how files are saved to the server, see “Saving imposed jobs”
on page 6-26.
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Chapter 6:
Advanced
Features of
DocBuilder Pro

This chapter provides information about the advanced imposition and editing features
of DocBuilder Pro. You can use imposition settings to alter various aspects of a job and
create custom templates.

Mixed Page mode and Fixed Page mode

DocBuilder Pro allows you to perform impositions in two different page modes. You
can switch between page modes by clicking the corresponding icons at the top of the

main imposition window.

Fixed Page mode—allows you to impose documents that contain pages that are all
the same size.

Mixed Page mode—allows you to impose documents that contain pages of
different sizes.

When you open the Imposition window for a document that contains different page
sizes, Mixed Page mode is selected automatically. You cannot switch to Fixed Page
mode. When you open the Imposition window for a document that contains a single
page size, you can select either Mixed Page or Fixed Page mode.
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Some imposition settings are available only for Mixed Page mode, and some only for

Fixed Page mode. The following table notes the settings that are exclusive to either

mode.
Settings Settin Available in Available in
panel 9 Fixed Page mode Mixed Page mode
Sheet Size Yes Yes
Creep Adjustment Yes Yes
Orientation Yes Yes
Duplex Yes Yes
Layout Rows/Columns Yes Yes
Printer’s Marks Yes Yes
Printer’s Marks: Pull No Yes
into Page Edge
Bleeds Yes No
Scale Apply To Not editable; always Editable
set to All Slots on
All Surfaces
Scale Mode Available options: Available options:
¢ Scale to Fit ¢ Scale to Fit
e Custom ¢ Custom
Alignment/Offsets No Yes, unless Scale to Fit
is specified
Finishing Binding Yes Yes
Gang Up Yes Yes
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Imposition settings

Imposition settings apply only to the job currently displayed in the main window.
Because these settings usually affect the job’s printed layout, they are saved with the job
and used whenever the job is opened. For example, as you open jobs saved with
different layouts, you see the display change accordingly. Changes to imposition
settings are applied to the current job immediately, but are not saved permanently until
you save the job itself.

You can specify imposition settings using controls in the Sheet, Layout, Scale, and
Finishing panes on the left side of the main window. To view or hide a settings pane,
click the bar for that settings group.

i Imposzition - BigLetts. pdf

Click to view or hide
the settings panel

Rows H Columns H
& Frinter's s
& Bleeds

NoTE: You can change the default unit of measurement for all input fields in the
Command WorkStation Preferences dialog box. You can also specify any unit of
measurement in any field that accepts input by adding one of the following
abbreviations to the new value:

s M o

* “L,” “in,” or the inch symbol (") specifies inches, for example: 8.5 i, 8.5 in, 8.5"
* “mm” specifies millimeters, for example: 8.5 mm

e “pt” or “pts” specifies points, for example: 8.5 pts



6-4 | Advanced Features of DocBuilder Pro

Sheet settings

Sheet settings allow you to specify characteristics of the paper on which the job is to be
printed, such as dimensions, thickness, orientation, and whether it will be printed on
one or both sides.

Because these settings affect virtually every other aspect of the imposition process, you
should specify sheet settings immediately after opening a job in the main window. If
necessary, you can change the settings later. The job is revised accordingly.

In general, experimentation with job settings does not cause permanent changes
(o1, potentially, loss of original job data), until the job is printed or saved with the

new settings.

Size

You can choose an item from the Size menu to specify the dimensions of a sheet of
paper and see the change reflected in the main window preview immediately. The Size
menu includes items representing all page sizes defined by the currently selected
copier’s PostScript printer description (PPD) file. To choose a custom size, enter the
width and height of the custom page. If you do not specify units for your custom size
values, DocBuilder Pro uses the default units specified in the Edit > Preferences dialog
box.

When specifying a sheet size setting, consider the size of the final output. During
imposition, DocBuilder Pro automatically scales pages, if necessary, to fit the sheet’s
maximum imageable area. The area does not necessarily extend to the edges of the
sheet. For example, if you perform 1-Up imposition of 8.5x11 pages onto 8.5x11
sheets, the final pages will be scaled smaller than 8.5x11. To retain your original page
sizes, specify a sheet size large enough to accommodate the imposed pages without
scaling.
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Creep Adjustment

Choose either Plain or Thick from the Creep Adjustment menu, or enter a value

(between 0 and 2 inches, or the equivalent in another measurement unit) to specify the
thickness of the sheet. When saddle-stitched binding is specified, DocBuilder Pro uses
this value to compensate automatically for binder’s creep (see “Shingling and creep” on

page A-8).

Note: Even if you choose Thick from the Creep Adjustment menu, your job prints on
Plain paper, unless you specified Thick paper in the job properties. For more
information on changing job properties from Command WorkStation, see “Viewing
and overriding print settings” on page 3-14.

Orientation

Use the Orientation menu to specify the orientation of a sheet. As an alternative to
rotating the sheet, you can perform custom rotations on any page in the main window,
as described in “Rotating pages” on page 6-22.

Duplex

Use the Duplex menu to specify the relationship of content areas on opposing sides of
a sheet. Specify On for duplex (two-sided) printing or Off for simplex (one-sided)
printing.

When you choose On, the job is printed as duplex using a Top-Top setting, meaning
that the tops of pages on opposing sides of a sheet are located on the same edge (usually
the preferred choice for imposed book layouts).
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Layout settings

A layout is a plan that specifies the number, ordering, and rotation of page images on
the sheet. DocBuilder Pro supports layouts of up to 25 pages per sheet, in a matrix of
up to 5 rows by 5 columns (50 pages duplex). All combinations of rows and columns
allow gang printing; however, only Gang Up layouts in the 5x5 matrix support
imposition.

Note: If the number of pages in your job does not divide evenly into the number of
rows and columns in the layout you select, you may see some sheets with blank spaces.
The layout you select should correspond to the number of pages in your job.

Rows

Click the Rows up and down arrows to specify the number of rows (up to five) in a
layout, or specify the number of rows in the layout by typing a value in the Rows field.
Changes to the Rows value are reflected immediately in the main window, whether you
are in Layout or Preview mode.

The Rows value interacts with the Columns and Scale settings. When you choose a
value that causes content to extend beyond the edge of the sheet, DocBuilder Pro
provides a visual warning. For more information, see “Clipping indicators” on

page 6-12.

When you change the Rows value, you are prompted with a message that all custom

page edits (Add, Delete, or Duplicate) applied to the job are canceled.
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Columns

Click the Columns up and down arrows to specify the number of columns (up to five)
in a layout, or specify the number of columns in the layout by typing a value in the
Columns field. Changes to the Columns value are reflected immediately in the main
window, whether you are in Layout or Preview mode.

The Columns value interacts with the Rows and Scale settings. When you choose a
value that causes content to extend beyond the edge of the sheet, DocBuilder Pro
provides a visual warning. For more information, see “Clipping indicators” on
page 6-12.

When you change the Columns value, you are prompted with a message that all
custom page edits (Add, Delete, or Duplicate) applied to the job are canceled.

Printer's Marks

Select Printer’s Marks to add trim, fold, and job information to all sheets in a job. For
background information on printer’s marks, see page A-4.

Note: Not all layouts display all of the Printer’s Marks. For example, if the layout you
select does not require that the sheet be folded, fold marks are not displayed, even if
you selected them in the Define Marks dialog box.

Job label

Trim marks

Fold mark
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Because the set of marks required varies according to the job, DocBuilder Pro allows
you to define the set of printer’s marks displayed. For example, ganged-up business
cards do not require fold marks, while a 4x4 book layout does. To specify which marks
are shown, click Define and choose options in the Define Marks dialog box.

Define Marks E

¥ Trim Marks Froperties... | _|
[+ Fold Marks Froperties... |

Horizontal Qffszet IU-UUUIZ't
Wertical Offset IU.DDDpt

Job Label
¥ Job Mame
¥ Sheet Irfo
¥ Diate & Time

™ Pullin to page edge

Cancel |

The Define Marks dialog box allows you to enable or disable trim marks, fold marks,
and the individual elements of the job label. The job label stores descriptive text used
for the job name, sheet information, and date and time. You can also enter values
(from —72 to +72 points, —1.0 to 1.0 inch, or —25.4 to 25.4 mm) in the Horizontal
Offset and Vertical Offset fields, to fine-tune the placement of trim marks and fold
marks. In Mixed Page mode, you can select Pull in to Page Edge to align trim marks
and fold marks with page boundaries.

Offset—The Horizontal Offset and Vertical Offset fields determine the gap between
the printer’s marks and the trim lines on the page. This allows you to move the printer’s
marks away from the final trimmed area of the page. A positive offset moves the
printer’s marks out from the center of the page, and a negative offset moves the
printer’s marks closer to the center of the page.

10 point vertical offset

10 point horizontal offset
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Properties—Click Properties to customize the appearance of trim marks and fold
marks. You can specify the horizontal and vertical lengths of marks (from 1 to 216
points), type (dotted or solid), width (from 1 to 3 points), and color.

Mark Properties E

Harizontal Length: I‘I 6.000pt
‘ertical Length: I‘I £.000pt

Type I Solid - l
Width : I 1pt. = l
Color.  [R] |~

Cancel |

Note: The Printer’s Marks option enables marks globally throughout a job. To disable
or enable an individual mark, press the Ctrl key and click the mark directly in the
imposition window. Disabled marks are indicated by an “X”.

—¥ L

Ctrl-click to disable/enable mark
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Bleeds

The Bleeds option moves the trim marks into the image by the amount you specify to
ensure that the printed area extends beyond the edge of the trimmed sheet.

Non-imageable area

Trim marks

Image

To specify horizontal and vertical bleed amounts for a job, click Define in the Layout
panel and enter values (from 0 to 72 points, 0 to 1 inch, or 0 to 25.4 mm) in the

Define Bleeds dialog box.

Harizontal |5.000pt
Wertical  |5.000pt

Cancel |

The Bleeds option is not available in Mixed Page mode.

Note: When you specify a bleed, you move the trim marks into the page by the bleed
value on both the top and the bottom of the page, and on both sides of the page.
Therefore, you reduce the size of your finished page by twice the bleed amount. If you
plan on using bleeds, design your image to be slightly larger than the size of the final,
trimmed page and select a larger paper size to accommodate trimming.
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Scale settings

Use Scale settings to enlarge or shrink the page by a specified amount.

Firi

Alignment

L
)
.

Apply To
In Fixed Page mode, the scaling settings you specify are applied to all pages in a job.
In Mixed Page mode, you can apply scaling to specific slots on sheets. The number of

slots on a sheet depends on the Rows and Columns values. The slot size is determined
by dividing the maximum imageable area of the sheet by the number of slots.

Current Slot—Applies scaling to the currently selected page.

Row on All Surfaces—Applies scaling to all pages on all sheets that are located in the
same row as the currently selected page.

Columns on All Surfaces—Applies scaling to all pages on all sheets that are located in
the same column as the currently selected page.

All Slots on All Surfaces—Applies scaling to all pages in the job.
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Scale Mode

Choose a scaling option from the Scale Mode menu:

Scale to Fit—Scales page(s) to best fill the slot without printing past its edge. Scale to
fit is the default mode.

Custom—Enables the Scale Factor and Finished Height and Width fields, so that you
can specify new scaling values. The original height and width values are displayed for
your reference. When you specify a value, DocBuilder Pro automatically updates the
other fields to preserve the height-to-width aspect ratio of the page.

Clipping indicators

If you supply scaling values that would cause the page to print past the edge of the
sheet, DocBuilder Pro provides a visual warning. When the window is in Layout
mode, any clipped page edge is highlighted in yellow. When the window is in Preview
mode, the Clipping icon appears to the left of the Scale Factor field. In addition, the
appearance of the page preview itself makes scaling problems obvious—content
truncates at the edge of the preview sheet, just as it would on a printed sheet.

I Scale factor W

Clipping icon

Clipped page edge
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Alignment and Offsets

The Alignment and Offsets settings are enabled when you choose Custom from the
Scale Mode menu in Mixed Page mode. You cannot change Alignment and Offsets
settings in Fixed Page mode.

The Alignment controls allow you to specify the placement of a page within its
predefined slot on the sheet. For example, if the page has been scaled smaller than the
slot, you can align the page to the upper-left corner of the slot by clicking the

Alignment control corresponding to that position.

Alignment af

Click to specify

0.000
upper-left alignment

Page is aligned in slot

You can fine-tune the placement further by entering values (from —5184 to +5184
points) in the Offsets fields. Offset values are calculated in reference to the alignment
position, and reset to zero when you specify a new alignment.
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Finishing settings

In the Finishing pane, you can specify binding and gang printing settings.

Finizhing

Q Gang Up

Binding

To enable binding settings and disable gang printing, select Binding. When binding
settings are enabled, you can specify the binding method, the binding edge of each
page (left or right), and the number of pages per saddle group. DocBuilder Pro
compensates automatically for binder’s creep according to the specified binding

method, the number of pages in a saddle group, the layout in use, and the size of the

job.

Note: If you are using a layout with more than two columns or rows, the Binding

selection is unavailable.

You can specify the following binding edge options:

Left Edge—Specifies binding across the left edge of the booklet. The booklet reads
from left to right.

Right Edge—Specifies binding across the right edge of the booklet. The booklet reads
from right to left.
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You can specify any of the following binding methods:

Saddle—Specifies a group of folded sheets stitched or stapled on a common, centered
fold line. Saddle-stitched binding is the most common type of binding, and is usually
used for booklets.

Perfect—Specifies signatures folded and stacked for binding. The spine edges are
trimmed and glued together.

Nested Saddle—Specifies a combination of saddle and perfect binding methods.
As with saddle stitching, pages are grouped together and stapled or stitched across a
common center fold. The saddle groups are then stacked one on top of another and

glued, as with perfect binding.

When imposing a book for nested saddle binding, specify the number of pages in each
saddle group by entering a value in the Groups of field. As the number of pages in a
saddle group increases, the effect known as binder’s creep becomes more prevalent
(see page A-8). DocBuilder Pro shifts images on the page to compensate automatically
for creep, according to the value in the Groups of field, the value in the paper thickness
field, the specified binding type, and the ordering and orientation of pages specified by
the current layout.

Gang Up

To enable gang printing and disable binding settings, select Gang Up. In gang
printing, you place multiple pages on a sheet for “collate and cut” finishing, rather
than having DocBuilder Pro impose them in the order required by a particular binding
method.

A collate and cut layout reorders pages in a manner that causes them to fall into easily
collated stacks when the sheets in the job are cut into individual pages. The use of such
a layout may allow multiple small jobs to be printed on a single sheet; thus, gang
printing is commonly used as a means of saving paper when printing small jobs on
copiers that use large sheets, and when printing jobs such as business cards or labels.

To disable gang printing and enable binding settings, select the Binding setting. When
gang printing is disabled, DocBuilder Pro imposes pages in the order defined by the
current layout.
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You can specify any of the following Gang Up methods:

Repeat—Places multiple copies of a page until the sheet is filled. For example, when
printing both sides of a sheet, the front side of the first sheet is filled with images of
Page 1, and the back side is filled with images of Page 2. The front side of the second
sheet is filled with images of Page 3, and the back side is filled with images of Page 4,
and so on, until all pages in the job are imaged.

Documents laid out in this order may tend to be collated more easily than when

printed in another order. The Repeat option enables what is commonly known as
“step-and-repeat” printing. Step and repeat is most often used when printing multiple
copies of a single document. For example, when printing business cards, you print
multiple copies of the same image to fill a larger sheet.

Unique—Places pages in an arrangement that is often more appropriate for printing a
single copy of a job. This option does not fully collate itself (hand collating is
necessary), but optimizes the sheet size while limiting the run to a single copy.
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Unique-Collate Cut—Places pages in an arrangement that allows the pages to fall into
the correct order when the sheets are stacked and cut. This option minimizes the need
for collating by hand and is most appropriate for printing single copies of a document.

12-page document

1112(13(|4([5]||6]||7]|8]|9]([10][11]|12

2 x 2 Unique-Collate Cut, Duplex off

1 4 2 5 3 6 Collate sheets
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2l

) L

7 H

=]y

—
o

Collate pages

v




6-18 | Advanced Features of DocBuilder Pro

Modifying the layout manually

Whether you apply a predefined layout or specify custom settings, you can manually
modify the layout of a job in the following ways:

* Reorder pages

* Add, duplicate, and delete pages
* Rotate pages

* Set gutter sizes

Note: Specify the following settings before making any manual changes to the layout:
Orientation, Duplex, Rows, Columns, and Binding. If you specify any of these settings
after making manual changes, you are prompted with a message indicating that the
manual changes will be cancelled.

Reordering pages in Layout mode

When you impose a job, its pages are automatically arranged in a particular order,
according to the layout you select. Each page number in Layout mode represents the
page from the source document that DocBuilder Pro images in a designated position
on the finished sheet. However, to reorder individual pages manually, arrange them in
the main window. To assign a different page to a particular location in the layout, use
the following procedure.

TOo REORDER PAGES

1.

2.

Verify that Layout mode is selected.

Select the location’s current page number.

You can also press Tab to move to the next slot in the layout, or press Shift + Tab to
move to the previous slot in the layout.

Type the new page value and press Enter.

You can add a blank cover page by typing 0 (zero) for any page number. Page 0 will be
printed as a blank page.
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NoTe: When you use this procedure to reorder pages, the page number you enter
overwrites the original. For example, if you typed Page 3 in place of Page 5, you
will now have two of Page 3 and no Page 5. Also, you cannot enter a page number
that does not already exist in your job. For example, if your job has 10 pages, you
cannot type 12.

Adding, duplicating, and deleting sheets

You can add, duplicate, or delete sheets by right-clicking any sheet in either Preview or
Layout mode.

To ADD OR DUPLICATE SHEETS

1. Right-click a sheet in Preview or Layout mode, and then choose Add Sheet(s) or
Duplicate Sheet from the menu that appears.

Zoom |n
Zoom out

Add Sheet(z]...
Duplicate Sheet...
Delete Sheet(z]...
Edit Fage ...

2. If you are adding sheets, specify the number of sheets to add.

Add Sheet|s] E

Dwuplex iz Off : Each Sheet has 1 Surface

MNumber of Sheet(z] to add: |1
' Add After Sheet |1

& add at end
' #dd at beginning

Cancel
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3. If you are duplicating sheets, specify the number of the sheet to duplicate.

Duplicate Sheet E
Dwuplex iz Off : Each Sheet has 1 Surface
Duplicate Sheet I‘I
5 Add After Sheet |1

 add toend
" dd to beginning

Cancel |

4. Select the location to insert added or duplicated sheets and click OK.

TO DELETE SHEETS

1. Right-click a sheet in Preview or Layout mode and choose Delete Sheet(s) from the
menu that appears.

The Delete Sheet(s) dialog box appears.

Dwuplex iz Off : Each Sheet has 1 Surface

' Delete Sheet I‘I
€ Delete &1l Shests After |1

 From |1 to |1

Cancel |

2. To delete a single sheet, select Delete Sheet and specify the number of the sheet you
want to delete.

To delete a range of sheets, select Delete All Sheets After and specify the starting
number of the sheet range to delete, or select From and enter values for the start and
end numbers of the sheets to delete.

A single sheet or range of sheets is deleted, depending on what you have specified.

3. Click OK.
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Editing page content

You can use the Enfocus PitStop software (installation instructions included with the
DocBuilder Pro option) to edit the content of pages in a job. PitStop functions as a
plug-in that adds enhanced PDF editing tools to Adobe Acrobat.

Note: For best results, make edits to page content before performing sheet-level
operations such as adding, duplicating, or deleting sheets. Editing page content causes
the cancellation of all previous sheet-level operations.

To use P1TSToP WITH DOCBUILDER PRO

1.

PitStop editing tools

Right-click a sheet in Preview or Layout mode and choose Edit Page from the menu
that appears.

Or, display the full-screen preview for the spooled/held PostScript or PDF job in
Command WorkStation (see page 4-3), and click the Edit Page icon.

F"T| ’T”T”t| M ’Ti Edit Page icon

(in full-screen preview)

Adobe Acrobat starts and displays the document. The standard Acrobat tools are
available for use, as well as the PitStop tools, which display with purple lines.

Adobe Acrobat - [00000000.000] [_]O]
T Ele Edit Document ook View Window Help |

ReEPs(E < rH s NOABSREEED0 DA

L 1=

PitStop
editing tools

[phrsls ApDesnh~med 20

k] 1o9ss [ A1 ote 85x1iin | B ||«
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2. Use the PitStop editing tools to edit the document content.
For instructions on using PitStop, see your online PitStop documentation. To access
this documentation, choose Help>Plug-In Help>Enfocus PitStop Professional from
the Acrobat menu.

3. When you have finished editing, click Close in the Acrobat window.

You are prompted to save the changes.
4. Click Yes.

5. Click the Command WorkStation window to bring it to the foreground.

The edited file appears in the full-screen preview window.

Rotating pages

To manually rotate individual pages or sets of pages in a job, display the job in Layout
mode and click the Rotate icon in the upper-right corner of a page. Rotation is
performed in 90° clockwise increments for Mixed Page mode, or in 180° increments
for Fixed Page mode.

If you apply a 90° rotation to a page in Mixed Page mode and then switch to Fixed
Page mode, the rotation will be canceled.

Rotate icon

=/}
ol

16 1
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TO ROTATE PAGES

1.

2.

To rotate a single page, click the Rotate icon on that page.

To rotate all pages in the job, press the Shift and Ctrl keys and click the Rotate icon on
any page.

6 8 L | ot 11| 9 ¢ | u

16 | 1 2 5 14 | 3 4 13
Sheet 1, Sheet 1, Sheet 2, Sheet 2,
front side back side front side back side

To rotate all pages in a certain location on the front side of each duplex sheet, press
the Shift key and click the Rotate icon on any page in that location on any sheet.

For example, in the preceding graphic, if you press the Shift key and click the Rotate
icon on Page 8, Page 6 rotates as well, because both pages are in the same location on
the front side of the sheet.

To rotate all pages in a certain location on the front and back sides of each duplex
sheet, press the Ctrl key and click the Rotate icon on any page in that location on
any sheet.

For example, in the preceding graphic, if you press the Ctrl key and click the Rotate
icon on Page 1, then Pages 2, 3, and 4 rotate as well, because they are in the same
location on the front and back sides of the sheet.

Setting gutter sizes

DocBuilder Pro defines the locations of gutters for you according to the layout and
sheet size governing the imposition of the job. In Layout mode, you can specify the size
of a gutter by entering a value in the gutter size field and pressing Enter. For example,
perfect-bound jobs typically require larger gutters than saddle-stitched jobs, in order to
provide room for grinding off the spines and gluing signatures together when the book
is bound.
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You can also specify a negative gutter value—for example, to join together two pages
located in adjacent slots, or to offset the effect of an excess bleed value.

(o0 ]
Vertical gutter size field
T
& &
8 g Margin
0.00m § = =

Horizontal gutter size field

16 1

Note: The size and location of the margin (the area between the outside edge of a
group of imposed pages and the edge of the sheet) is a function of the particular copier
associated with the job. You cannot define custom margins.

Managing templates

You can name and save the current combination of Sheet, Layout, Scale, and Finishing
settings as a custom template. Choose Preferences from the File menu to set the folder
or directory in which Command WorkStation saves templates (see “Setting
preferences” on page 2-27).

You can save all imposition settings in custom templates, except the following:
* Sheet size setting
., .
* Custom printer’s marks properties
* The Pull into Page Edge setting and custom offset settings for printer’s marks

* The Apply To setting in the Scale pane
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* Settings made in Custom scale mode in the Scale pane
* Offsets settings in the Scale pane

* Fixed Page Mode or Mixed Page Mode settings

Added, duplicated, or deleted sheets

To SAVE IMPOSITION SETTINGS AS A TEMPLATE

1. Click the Save template icon.

Save template

i Imposition - BiglLetts_pdf

Template "
— 1 -Lp full bleed Delete template

Name of current template

2. Type a name for the settings file in the Save Template As dialog box.

When saving a template, choose a descriptive name, such as “4-Up Nested Saddle.” If
you plan to use the same template for a particular document, name the template after
the document type, for example, “Status Report.”

Save Template As E

|4-up nested

3. Click OK or press Enter.

Apply the template in the same manner as built-in templates, by choosing the template
from the Template menu.

TO DELETE A SAVED TEMPLATE

1. Select the template you want to delete from the Template menu.
2. Click the Delete template icon.

3. Click OK or press Enter to delete the specified template.
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Tips for using the Imposition feature of DocBuilder Pro

This section provides information that will help you get the most out of the imposition
features of DocBuilder Pro.

Page-level operations

Consider the following when editing pages of a job:

¢ Adding a binding offset

You can set gutters on each page independently to allow extra room for binding. For
more information, see “Setting gutter sizes” on page 6-23.

e Perform all page-level edits in the Preview window

For best results, perform all desired page editing operations in the Preview window
before applying imposition settings to a file. Although you can perform page edits, such
as adding, deleting, and duplicating pages, within the main Imposition window, these
edits will be lost when you apply imposition settings that alter the page layout.

Saving imposed jobs
When you save an imposed job, DocBuilder Pro does the following:

e If new data has been added to the temporary PDF file, it is saved to the Fiery EX2101
under the name you specify in the Save As dialog box.

The default name that appears in the Save As dialog box is that of the original
spool file, with a new extension (.dbp). If you do not intend to overwrite the
source file, you must enter a new name for the imposed job. The original
PostScript or PDF remains intact, even after the converted file has been edited and

saved in the Imposition window.

e If imposition data has changed, the data is saved to the Fiery EX2101 and associated
with the new PDF.

Maintaining associated imposition data separately from the job’s PDF data allows
DocBuilder Pro to impose in-RIP without modifying the PDF data, and allows you to
reuse PDF data that has been modified in the imposition process.
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TO SAVE AN IMPOSED JOB
1. Click the Close Window icon in the upper-right corner of the DocBuilder Pro window.

2. Enter a name for the imposed job in the Save As dialog box.

Save As E

The job haz been changed. Do you want to save it?

0ld name:  BigMume. pdf

Mews name: IBigN umsz.pdf.dbp

es | Mo

3. Click Yes.
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Chapter 7:
Fiery WebSpooler
and Fiery Spooler

Fiery WebSpooler and Fiery Spooler duplicate many of the functions and features of
Command WorkStation. Each provides additional flexibility by allowing job tracking
and management from multiple platforms over the Internet or an intranet.

* Fiery WebSpooler is accessed with an Internet browser from the Fiery EX2101
home page.

* Fiery Spooler is installed from the User Software CD, and is available for Mac OS
computers only. To use Fiery Spooler, users need only a network connection to the
Fiery EX2101.

Note: The interface of Fiery Spooler for Mac OS computers is virtually identical to
that of Fiery WebSpooler.

Tracking and managing jobs with Fiery WebSpooler
Use Fiery WebSpooler to perform the following functions from your workstation:
* Opverride current job option settings.

* Delete jobs and cancel processing.

* Duplicate or rename jobs.

* RIP a job and hold the raster data.

* Hold jobs in the spooled area or the RIPped area.

* Remove raster data from RIPped files.

* Change the priority of jobs.

* Edit and merge raster data jobs.

* Display, print, export, or delete the Job Log

Most of these functions require an Administrator or Operator password. However,
even without a password, you can log in to Fiery WebSpooler as Guest with view-only
privileges.

NoTe: Most Fiery WebSpooler commands are identical to those of Command
WorkStation. For more information on specific commands, see Chapters 2 and 3.
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TO ACCESS THE FIERY WEBSPOOLER WINDOW
1. Start your Internet browser.
2. Enter the IP address or DNS name of the Fiery EX2101.

Consult the operator or administrator for this information.

The Fiery EX2101 WebTools home page appears.

0 ==——————Netscape:FieryWebTools:ESCHER-2 =—————— &5

E'ewmifnsaging' ﬁe,ry WebTOOIS

Status
WebDownloader Fery WebTools enable you'to observe,
WebSetu, manage, and manipulate the flow of print
N P jobs to the Fiery from your Java-enabled. ™
WebSpooler ‘web browset.
Installer

3. Click WebSpooler in the list of WebTools on the left side of the home page window.

4. To log in as Administrator, enter the Administrator password and click OK.
To log in as Operator, enter the Operator password and click OK.
To log in as Guest, click OK, without entering a password.

If the administrator has not set an Administrator or Operator password in Setup, you
are not prompted for a password.
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The Fiery WebSpooler window appears in a new browser window.

ZT wWebSpooler - AERD M= B
Fie Job Fage ‘Windaw Help

|Time  |Date s 8 8 .

yellowpeppers_ 4 0171810

word5paglirp.ps Administrator 07:39:38 011803
TigerTIF.ps Administrator 07:39:28 011803
J.Brahms.ps Administrator 07:3812  01n8m3
1215 RaceCar.ps Administrator 07:37.47  0118m3
cookies.ps Administrator 07:37:33 011803

brisgue: Administrator 0118/ 8
brisquel Administrator 063338 0118m3 1 fero 8B.6 KB

0 08 01180
1cookies.ps Administrator 074453 011803

Printable Area pdf Administrator 07:3405 011803

ps.pdf Administrator 07:3405 011803
ps.ps Administrator 07:3405 011803
test pdf Administrator 07:34.05  0118/03

waining: Applet Window

About the Fiery WebSpooler window

Similar to Command WorkStation, Fiery WebSpooler allows you to view
Fiery EX2101 and copier functions, and acts as an interface from which you can
control those functions.

The Fiery WebSpooler window is divided into three areas by Spool, RIP, and Print
status bars. When the Fiery EX2101 receives print jobs, the Fiery WebSpooler window
becomes a dynamic display, filled with the names of jobs and their characteristics.

The Spool, RIP, and Print areas of the Fiery WebSpooler window represent the stages
of printing a job. Jobs come in at the top level (Spool) and drop down to the Print
level, unless they are held along the way.

The job icons displayed in the Fiery WebSpooler window are explained on page 7-8.

The RAM status bar indicates the amount of memory in use. The Drive status bar
indicates the amount of hard disk drive space in use.
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NoTEe: In the Fiery WebSpooler window, the background color for the yellow and white
printer icons is the same.

Spooled jobs—TJobs listed in the area below the Spool status bar are PostScript or PCL
files stored on the Fiery EX2101 hard disk drive. These jobs were sent to either the
Print queue (white icons) or the Hold queue (yellow icons).

RIPped jobs—TJobs listed in the area below the RIP status bar are ready to print. They
have been rasterized (RIPped, or processed for printing) and are waiting, in order, for
access to the printer. Rasterized jobs can also be held; held jobs are indicated by a

yellow icon.

Printed jobs—Jobs listed in the area below the Print status bar have already been
printed. Printed jobs can be stored on the Fiery EX2101 hard disk drive. The number
of jobs you can store (from 1 to 99) is defined in Setup.

If you are logged in as Administrator or Operator, you can interact with a job wherever
it appears in the window by selecting it and choosing a command from the Job menu,
or by double-clicking the job and setting override options. For more information, see
“Manipulating job options and job flow” on page 7-5.

Errors—Jobs with an error are shown in red. To display the error, double-click the job.
Note that you cannot check the job properties or hold a job with an error.

Note: If your job does not appear anywhere in the Fiery WebSpooler window, it may
have already printed; if so, it appears in the Job Log. To view the Job Log, choose Show
Job Log from the Window menu. For more information on the Job Log, see page 7-17.

If the job does not appear in the Job Log, it may have been moved to the Archive
window by the operator. The Archive window cannot be viewed with Fiery
WebSpooler. To check this, you must contact the operator or go to the Command
WorkStation screen.
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Manipulating job options and job flow

Using the commands in the Job menu, you can alter the destinations, priorities, and

characteristics of jobs that appear in the Fiery WebSpooler window.

Delete Job(z)
Cancel Printing
Cancel RIFping
Duplicate Job(z)
Rename

Hald

RIP and Hold
Prirt

Prirt and Hold
Process Mest
Remove Faster

Owerride Print Settings...

Thumbnail &
Thumbnail B

To understand the effect each of these commands has on a job, you must understand
the way the Fiery EX2101 handles PostScript, PCL, and raster data, and how jobs are

activated or held in the various stages of processing. For this background information,

see Chapter 1 before manipulating jobs with Fiery WebSpooler.

Choose this command
from the Job menu

To do this

Raster data is

Delete Job(s) Delete the job(s) from the list. Deleted

Cancel Printing Cancel the currently printing job. Deleted

Cancel RIPping Cancel the currently processing job. Deleted

Duplicate Job(s) Duplicate one or more selected PostScriptor | n/a
PCL data jobs in the Spool or Print areas (Duplicate is not available for raster jobs.)
(creates a reference to the original job, with
the same name).

Rename Rename the job (PostScript or PCL file with | Unaffected, but associated with the new

or without raster).

name
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Choose this command
from the Job menu

To do this

Raster data is

Hold Hold the job in the current place (except for | Held in RIP area indefinitely, if included
a printed job, which is moved to the Spool with job
or RIP area).
RIP and Hold RIP the job and hold it in the RIP area. Held in RIP area indefinitely
Print Print the job in its turn (RIP the job first if it | Temporarily held on the server until the job
does not have raster data). Keep the printed | has completed printing
job in the Print area until the job limit is
reached.
Print and Hold Print the job in its turn (RIP the job firstif it | Held in the RIP area indefinitely (saved to
(like the PPD option does not have raster data). disk)

Save Fast Reprint)

After printing, hold the PostScript or PCL
data and the raster in the RIP area.

Process Next

Give top priority to this job.

Print the job (or RIP and print) as soon as
the processor and copier are free, before
other waiting jobs.

Held in RAM after printing (can be selected
in the Print area while it remains there), or
held in RIP area (saved to disk) if
destination was RIP and Hold

Remove Raster

Remove the raster from a job that has raster
data; leave the PostScript or PCL job in
place.

Deleted

Override Print Settings

Change the print options for the job
(see page 7-7).

Deleted and regenerated, if the newly
selected options require reRIPping, or
reprinted with the new settings, if none
require reRIPping

Thumbnail A Open the selected held raster data job in the | Changed if job is edited, unaffected if job is
Thumbnail A window, where you can viewa | only viewed
full-screen preview of the job, edit the job,
or merge it with raster data from other jobs.

Thumbnail B Open the selected raster data job (not Unchanged

necessarily a held job) in the Thumbnail B
window for viewing or for merging into a
job in the Thumbnail A window.
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Overriding job option settings

To change the job options of a job, select the job and choose Override Print Settings
from the Job menu. Click the tabs in the Override Print Settings dialog box to see all
the job options.

«
Paper Source | Destination | Layuutl Finishing | FreeForm | Image Qua\iml Installable Options | Motes
£ Media Type [Narmal =l 3
¥ Media Calor |Wh\le j
Transparency Interleaving |Ofr j
Slip Shest |or =
Slip Sheet Paper Source |Auto Select j
& Slip Sheet Page Size |egx1p =
Mixed Media In Use [na =
Print Size |Same as Document Size j
& Tray Alignment |Di5ab|e j
Paper Source |AumSelecl j
&2 Page Size |B.5;ﬂ1 P j
Custom Page Size!
Units |mnh j
I
|Warning: Applet Window

Note: For some options, changing the setting requires that the job be reRIPped.
These options are displayed with an icon to the left of the option name.

The options set here are the same ones you set from the Print dialog box when you
print from an application. For information about setting and overriding these print
options, see Appendix A of the Printing Guide.
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Job icons

Three types of icons are used for both active jobs and jobs on hold.

Icon

Active jobs
(white icons and rows)

Jobs on hold
(vellow icons and rows)

Printer icons

PostScript, PCL, or raster
data headed for printing
(top) or after printing
(bottom)

PostScript or PCL data headed for
Print and Hold or job on Hold
after printing (Hold)

Raster icon

PostScript, PCL, and raster
data after printing, ready for
fast reprint

PostScript or PCL data already
rasterized and held

Spool area

The job icons in the Spool area are as follows:

Spool area icon

What it indicates

How long you see the job

PostScript or PCL data from a
user on the network; no
destination is defined

Until a destination is chosen

Until the RIP is free

headed for Print and Hold

2 PostScript or PCL data
E headed for Print

3 PostScript or PCL data
E headed for RIP and Hold

4 E PostScript or PCL data

The Spool area is both the receiving area for jobs from users on the network (Hold

queue) and the waiting area for jobs that will be RIPped.
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Hold queue jobs—When printing requires an operator (because the Print queue and
Direct connection are disabled), the operator must assign a destination to all jobs
received from users on the network (Icon 1). Once assigned, jobs move down the
Spool queue for processing (Icons 2, 3, and 4). All jobs printed to the Hold queue
require routing by an operator.

Print queue jobs—When printing does not require an operator, network jobs sent to
the Print queue appear in the Spool area, where they are displayed with a white printer
icon (Icon 2). When jobs reach the head of the queue, they are RIPped and printed
without operator intervention.

Direct Connection—Jobs printed to the Direct connection are not displayed in the job
lists. They are displayed briefly in the status bars (where they cannot be selected) and
are included in the Job Log.

RIP area

The job icons in the RIP area are as follows:

RIP area icon

What it indicates

How long you see the job

Raster data, no destination
defined; may have been
printed before and held

Until it is deleted, moved to
the Archive window, or
stripped of its raster data and
sent to the Spool area

e

Raster data headed for Print
in its turn; no hold defined

Until copier is free to print

the job

After a job is rasterized, it goes into the RIP area. The RIP area holds only jobs with
raster data. Jobs in the RIP area are either waiting for the copier to be free (Print queue
jobs, Icon 2), or they are being held (Icon 1). Held jobs in the RIP area have already
been rasterized (RIP and Hold), or they have been printed and their raster data has
been routed back to the RIP area (Print and Hold).

NoTEe: Raster jobs in the RIP area that are waiting to print (Icon 2) cannot be
manipulated by job commands.
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Print area

The job icon in the Print area is as follows:

Print area icon What it indicates How long you see the job
1 PostScript or PCL data Until the job limit is reached
n only—raster data has been
deleted

The Print area, also referred to as the Printed queue, contains jobs that have already
been printed. These jobs were assigned the Print destination (white printer icon in the
Spool or RIP areas) without any Hold instructions; therefore, they all have white icons.

NoTE: A job row that appears in light red indicates that an error occurred while
printing the job. To see the error, double-click anywhere in the row.

While it is printing, a job consists of PostScript or PCL and raster data. The raster data
in RAM is not cleared until memory is needed to rasterize the next job. As long as the
raster data is intact, the job can be reprinted from the Printed queue. Printed jobs are
represented by a white PostScript icon (Icon 1). If the job was printed from a held
raster job (in the RIP area), the raster data in the RIP area remains and can be used to
reprint the job after the raster data has been cleared from the Printed queue.

Previewing, editing, and merging jobs

Fiery WebSpooler includes two thumbnail windows that allow you to preview and edit
raster data. You can use the thumbnail windows in the following ways:

¢ In Thumbnail A, you can view the currently printing job as it is RIPping, or any
raster data job.

* From Thumbnail A, you can open a full-screen preview of a raster file.

* Using Thumbnail A and Thumbnail B together, you can merge raster data from
more than one file, even if the files were printed from different applications on
different computer platforms.



7-11 | Previewing, editing, and merging jobs

The job merge features eliminates the limitations of certain software applications. You
can merge raster pages of documents of different types, and from different computer

operating systems. You can merge color pages from graphics programs with text pages
from a word processor.

Previewing raster jobs

You can use Thumbnail A to preview pages of the currently RIPping job. You can also
use Thumbnail A and Thumbnail B to preview any held raster data job in the RIP area.

The thumbnail windows also allow you to open a thumbnail view of any held raster
data job in the RIP area and perform electronic collation or document merging. For
more information about this feature, see page 7-14.

Previewing the currently rasterizing job

To see the progress of jobs as they are RIPped, leave Thumbnail A open in RIP
Preview mode.

TO VIEW THUMBNAILS OF THE CURRENTLY RIPPING FILE

1.

2.

Click the Thumbnail A tab at the right of the Fiery WebSpooler window.

Click the RIP preview icon at the left side of the Thumbnail A window.

In this mode, Thumbnail A displays each page of the currently processing job after it
has been RIPped.

Click to display the
currently rasterizing job

Click to close the
thumbnail window

BEEE]D
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3.

4.

Choose a PostScript file in the Spool or Print area and select RIP and Hold, Print,
or Print and Hold.

As pages are RIPped, they are displayed in Thumbnail A.

When you have finished viewing, click the Thumbnail A tab to close the
thumbnail window.

To VIEW THUMBNAILS OF ANY RASTER DATA FILE

1.

2.

Select any raster data job in the RIP area.

Choose Thumbnail A or Thumbnail B from the Job menu.

Note: Wait until all pages have been displayed before opening another raster file with
Thumbnail A. If the job contains many pages, it may take some time for the entire job
to be displayed.

Job ‘Bighums. pdf [6 page(s)]  Page Size: Letter

Click to open a
full-screen preview

1 2 3 Click to close the

thumbnail window

EEE =R

Kak| 3

When you have finished viewing, click the Thumbnail A or Thumbnail B tab to close
the thumbnail window.
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Displaying full-screen previews
You can open a full-screen preview of any page in the Thumbnail A window.
The full-screen preview is a view-only display, and it takes time to retrieve the data.

TO OPEN A FULL-SCREEN PREVIEW
1. In Thumbnail A, select a page and click the Full Preview icon at the left of the window.
You can also display full-screen previews by double-clicking the page in Thumbnail A.
Note: If you have edited a job using the thumbnail windows, you must save the edited

file before you can view full-screen previews of all its pages.

2. To close the full-screen preview, click the “X” button above the preview.

Z webSpooler - AERD [_[O] ]
File Job Page ‘Window Help
|
I X -
=] Click to close the
] full-screen preview
L
5
{=-]

If scroll bar appears,
click arrows or empty
spaces, or move bar to
scroll up or down

['w/aring: Applet Window I

If scroll bar appears,
click arrows or empty
spaces, or move bar to
scroll left or right
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Editing and merging raster files

The ability to work with raster files gives you new opportunities to combine
documents from different sources into a single file. For example, you can combine
covers and chapter head pages created in a page layout application with text pages
created in a word processing application, or customize a slide presentation by inserting

slides from a different presentation graphics application.

You can display two raster files at once: a source file and a target file. The target file
appears in Thumbnail A, and the source file appears in Thumbnail B.

NoTE: You cannot create a new PostScript file in this process; you must print the

merged file, which has references to the original PostScript files. Before editing or
merging raster files with the thumbnail windows, make sure the source files were

RIPped using the print option settings you want for the final output.

To VIEW AND EDIT RASTER DATA JOBS

1.

2.

Click to open a full-screen
preview of the page

Select a raster data job in the RIP area, and choose Thumbnail A from the Job menu.

Open the Page menu to see the commands available for pages in Thumbnail A.

You can also access most of these commands by clicking the icons along the left side

of Thumbnail A.

You can use the slider bar at the bottom of the window to scroll through pages in

Click to duplicate a page

Click to delete a page

Kal| 3
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Delete—Deletes the currently selected pages.
Duplicate—Duplicates the currently selected pages.

Preview—Opens a full-screen preview of the currently selected page (see “Displaying
full-screen previews” on page 4-3).

Undo—Reverses the action of recently performed page edits.
To move pages within Thumbnail A, click to select the pages and hold down the mouse
button as you drag the selected pages to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple,
non-sequential pages.

To move pages to a new position, drag until a blue highlight appears in the desired
position, and then release the mouse button.

Note: If you move the pages on top of existing pages, the existing pages will
be overwritten.
When you are finished editing, click the Thumbnail A tab.

If you have edited the job, you are prompted to save the job.

Enter a new name and click OK.

The new file is now located in the RIP area, ready to print. If you saved the edited file
with a new name, the original source file remains held in the RIP area.

TOo MERGE TWO RASTER DATA JOBS

1.

In Thumbnail A, display the job you want to edit.
The file must be a held raster data job in the RID area.

In Thumbnail B, display another held raster job from the RIP area.

The Thumbnail B tab opens a second thumbnail view, which cannot be edited but can
be used as a source for pages added to the document in Thumbnail A.

Note: To merge documents, the page sizes of the source document and the target
document must be the same. Before editing or merging raster files with the thumbnail
windows, make sure the source files were RIPped using the print option settings for the
final output.
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3.

In Thumbnail B, click to select the pages and hold down the mouse button as you drag
the selected pages to the new location in Thumbnail A.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple,
non-sequential pages.

To scroll through the pages in Thumbnail A and Thumbnail B, drag the slider bar at
the bottom of the screen, click the empty area to the left or right of the slider bar, or
click the arrows.

To replace pages, drag Thumbnail B pages on top of pages in Thumbnail A. To add
pages, drag the pages to a new position in Thumbnail A. When the pages are ready to
be added, a blue highlight appears in the new position.

ﬂl Job ‘BigLetts.pdf' [6 pa

Thumbnail B

Joh '‘BiglLetts.pdf [T pagais)] Fage Size: Letter

Page 1 copied from the
document in Thumbnail B
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Multiple levels of undo are available. Use Undo to undo all the way back to your first
edit. There is no Redo function.

NoTe: Make sure to save the merged job before deleting any of the jobs you used to
create the merged job.

Thumbnail B pages moved into Thumbnail A adopt some specific attributes of the
Thumbnail A job, such as the document and user name.
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4. To close a thumbnail window, click the same tab you used to open it (the Thumbnail A

or Thumbnail B tab).
If you have edited Thumbnail A, you are prompted to save the job.

Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print, together with the original
source and target files.

Note: When multiple users are connected to the Fiery EX2101 via Command
WorkStation, Command WorkStation LE, Fiery WebSpooler, or Fiery Spooler, and
one user makes changes to a Thumbnail A job, not all users may see the results of those
changes. If you are unable to view changes in a job, or if selecting a thumbnail window
results in a message indicating zero pages, close and restart Command WorkStation,
Command WorkStation LE, Fiery WebSpooler, or Fiery Spooler.

Using the Job Log

From Fiery WebSpooler, you can view and print a log of all jobs printed by the
Fiery EX2101, including jobs downloaded with Fiery Downloader.

NoTEe: If you logged in as Administrator, you can delete the Job Log from Fiery
WebSpooler (see page 7-19). The Job Log is not available if you logged in as Guest.

TO DISPLAY, UPDATE, PRINT, DELETE, AND SAVE/EXPORT THE JOB L0G

1.

2.

3.

Choose Show Job Log from the Fiery WebSpooler Window menu.

Select All or specify a date range.

Job Log Range E

Select Job Log Range

 Date Month  Day Year

[15 [z003 0K, |
lF |2003 Cancel |

Fromm:

To

7
7

|W'aming: Applet Window

Click OK.

The Job Log appears in a new browser window.
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NoTe: The Delete button appears only if you logged in as Administrator.

Update
ZW WebSpooler - AERD Print
File Job Page Window Help

Delete

Export

Cancel 10.ps amandah 022703 170421 171035 00:00:01
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0K BiglLetts pdf kewin 03/01/03 01:41:43 01:51:44 00:00:01 B.7 KB
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\wiarning: Applet Window

The Job Log displays each job and information about the job, including status,

document name, user name, date, start time, end time, process time, page description
language, file size, device, paper size, media, number of originals, total number of
pages, and Notes.

The Status column provides the following information about jobs:
OK The job printed normally.
ERROR An error occurred during processing or printing,

CANCEL The job was canceled before printing was completed.

To update the Job Log, click the Update button.

To print the Job Log, choose Print Job Log from the File menu or click the
Print button.

The information displayed in the Job Log window prints to the current Fiery EX2101.
When you print the Job Log, totals are printed for all appropriate columns.
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If you logged in as Administrator, you can choose Delete Job Log from the File menu
or click the Delete button to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.

To save the Job Log, choose Export Job Log from the File menu or click the
Export button.

In the File name area, enter a name for the Job Log.

Browse to the location where you want to save the file and click Save.
The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are
separated by tabs.

To return to the job list, choose Show Job List from the Window menu.

Fiery Spooler for Mac 0S computers

For Mac OS, the Fiery Spooler interface is almost identical to that of Fiery WebSpooler
(see “Connecting to a different Fiery EX2101 from Fiery Spooler” on page 7-21).

Starting Fiery Spooler

Use the following procedure to start Fiery Spooler.

To START FIERY SPOOLER ON A MAC OS COMPUTER

1.

2.

Double-click the Fiery Spooler icon.

Select the Fiery EX2101 in the Chooser window.

For information on setting up the connection to the server, see the User Soffware
Installation Guide.

Click OK.

Log in to the Fiery EX2101.
To log in as Administrator, enter the Administrator password and click OK.
To log in as Operator, enter the Operator password and click OK.

To log in as Guest, click OK without entering a password.
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The Fiery Spooler main window appears.

iery Spooler
Time

08:51:0
Yiolin BW ps 08:50:52 201103 device
Times ps 08494 201103 device
tailor Bw ps 08:49:43 201103 device
SOUTHTABRGEps  heidi 08:48:14 201103 device
NORTH.Cvr RGB ps heidi 08:48:57 201103 device
Market BW ps heidi 08:48:50 201103 device

For details on managing jobs in Fiery Spooler and Fiery WebSpooler, see
“Manipulating job options and job flow” on page 7-5. For details on the job icons that
appear in Fiery Spooler, see “Job icons” on page 7-8.

The RAM status bar indicates the amount of memory in use. The Drive status bar
indicates the amount of hard disk space in use.
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Connecting to a different Fiery EX2101 from Fiery Spooler

Although the Fiery Spooler for Mac OS and Fiery WebSpooler interfaces are nearly
identical, the method for establishing and changing a connection to the Fiery EX2101
differs between the two.

With Fiery Spooler, you can connect to a different Fiery EX2101 using the following
procedure.

TO CONNECT TO A DIFFERENT FIERY EX2101

1.

2.

Choose Open Fiery from the File menu.

Select the Fiery EX2101 in the Chooser window.

For information on setting up the connection to the server, see the User Soffware
Installation Guide.

Click OK.

The Fiery Spooler main window appears.
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Chapter 8:
Using FieryBar

With the Fiery Advanced Controller Interface (FACI) installed, you can use FieryBar
to view Fiery EX2101 status information, start software, set up and restart the

Fiery EX2101, delete stored jobs, cancel active jobs, and log off from Windows. While
most elements in FieryBar have counterparts in Command WorkStation, you can view
current functions on FieryBar when Command WorkStation is not running,.

Note: FieryBar is available as part of the Fiery Advanced Controller Interface, which is
an optional upgrade. For more information, contact your authorized service/support
technician.

Introduction to FieryBar

FieryBar, located at the top of the monitor screen, includes the following:

RIPping area Printing area Activity light

RIPping

Printing

: Idle | de B

Click to expand or collapse FieryBar

RIP status area Message area

Status
FieryBar displays the following status information for the Fiery EX2101:
RIPping area Name of the job currently processing

RIP status area Amount of the job that has processed

v RIPping Printing

) Test Page M Idle 4

Printing area Name of the job currently printing

v RIPping Printing

n [+ ][] 4 Test Page 4

Message area Error messages and other Fiery EX2101 information

~ RIPping Printing

. Idle 4 Test Page 4
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Activity light

The activity light in the upper-right corner of FieryBar indicates current Fiery EX2101
activity. If the light is:

Solid red An error has occurred, causing the Fiery EX2101 to be
disabled. Check the message area for details of the error.

Flashing red An error has occurred, causing printing to be disabled, but
the Fiery EX2101 is capable of processing. Check the

message area for details of the error.
Solid green The Fiery EX2101 is idle.

Flashing green The Fiery EX2101 is processing or printing a job, or
communicating with a remote computer. Check the RIPping
area, the RIP status area, and the printing area for details.

No light The Fiery EX2101 is starting up.

Commands

Right-clicking FieryBar or the Fiery icon in the Windows taskbar enables you to access
many Fiery EX2101 features. You can choose the following commands from the menu
that appears:

Command WorkStation Starts Command WorkStation. For more information
on connecting to and using the features of Command
WorkStation, see Chapters 2 and 3.

Setup Fiery Opens the Fiery EX2101 Setup dialog box.
For more information about the Setup options, see the

Configuration Guide.

Scan Scan documents directly to Fiery Scan from the copier
glass or Automatic Document Feeder (ADF).

Restart Fiery Shuts down all Fiery EX2101 activity in the correct
manner before restarting. Use this option instead of
the power switch on the back of the Fiery EX2101 (see
“Starting and shutting down the Fiery EX2101” on
page 8-4).



8-3 | Introduction to FieryBar

Clear Server

Cancel RIP

Cancel Print

Suspend Print

Resume Print

Run Diagnostics

e Test I/F board

e Test Email

Log Off Windows

Hide FieryBar

Clears all jobs in all server queues, all jobs archived on
the Fiery EX2101 hard disk, all FreeForm masters, the
index of FreeForm masters (in the FreeForm window),
and the index of archived jobs (in the Archive
window). Before choosing Clear Server, consult your

administrator.

Cancels the job currently processing on the
Fiery EX2101.

Cancels the job currently printing on the
Fiery EX2101.

Suspends communication between the Fiery EX2101
and the copier. You must suspend printing if you want
to interrupt the current Fiery EX2101 job so you can
use the copier to make copies or print another job first.
Jobs continue to process on the Fiery EX2101. After
you make the copies, choose Resume Print to continue

printing jobs from the Fiery EX2101.

Resumes communication between the copier and the
Fiery EX2101 after you have finished making copies or
printing other jobs.

This option is provided for service representatives only.
Contact your authorized service/support technician
for information about running this diagnostic.

Sends a test e-mail to the system administrator’s
account specified during Setup. Check the e-mail log
to verify that the e-mail was sent successfully. Before
this option can be used, the E-mail printing feature
must be enabled in Setup. For details, see the
Configuration Guide.

Closes all open programs, enabling you to log on as a
different user.

Hides FieryBar. To show FieryBar after hiding it,
right-click the Fiery icon on the right side of the
Windows taskbar and choose Show FieryBar from the
menu that appears.
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Starting and shutting down the Fiery EX2101

Generally, you can leave the Fiery EX2101 running all the time. This section describes
how to shut down and restart the Fiery EX2101 when necessary.

To START THE FIERY EX2101

1. Press the power button on the front of the Fiery EX2101. If the copier is also turned
off, turn it on before turning on the Fiery EX2101.

2. At the Log On to Windows prompt on the monitor, keep Administrator in the user
name field, enter Fiery.1 in the password field, and press Enter.

3. Allow FieryBar to appear and reach Idle on the monitor.

When FieryBar displays Idle, you can enter Fiery EX2101 Setup by right-clicking
FieryBar and choosing Set Up Fiery from the menu that appears.

The Setup dialog box includes the following tabs:

Click To do this
General Setup Configure the General Setup options.
Network Setup Configure the Network Setup options.
Printer Setup Configure the Printer Setup options.

For information about the Setup options, see the Configuration Guide.
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Restarting the Fiery EX2101

Use the following procedure to restart the Fiery EX2101, rather than using the power
button on the front of the Fiery EX2101.

To RESTART THE FIERY EX2101

1.

Make sure the Fiery EX2101 is not receiving, processing, or printing a job.

Make sure that both the RIPping and Printing areas on FieryBar read Idle.

Note: If a job from the Print queue is processing, it will continue processing and print
after the Fiery EX2101 is restarted. If a job sent to the Direct connection is processing,
it will not finish processing or printing.

Right-click FieryBar and choose Restart Fiery from the menu that appears.
A Warning dialog box appears.

Click OK to restart the Fiery EX2101.
Allow the Fiery EX2101 to start up.

At the Logon to Windows prompt on the monitor, keep Administrator in the user name
field, enter Fiery.1 in the password field, and press Enter.

Allow FieryBar to appear and reach Idle on the monitor.
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Shutting down the Fiery EX2101

You may need to shut down the Fiery EX2101 for service. When you do so, fonts that
have been downloaded to the hard disk are not deleted. Print jobs in the Hold and
Printed queues and jobs that have been processed but not printed are not deleted and
are available for printing when you restart the Fiery EX2101.

To SHUT DOWN THE FIERY EX2101

1.

Make sure the Fiery EX2101 is not receiving, processing, or printing a job.

Make sure that both the RIPping and Printing areas on FieryBar read Idle. If a job has
just finished processing or printing, wait at least five seconds after the RIPping and
Printing areas switch to Idle before proceeding to the next step.

Note: If the Fiery EX2101 is receiving, processing, or printing a job when you shut it
down, it will not automatically finish doing so when you restart it. Instead, you must
resubmit the job after it has restarted.

Click Start on the Windows taskbar and choose Shut Down.

Select Shut Down and click Yes.
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Appendix A: This chapter introduces the basic concepts of imposition and can be used as an

Basics of
Imposition

introductory tutorial for imposing a document that will be printed as a book or
booklet. For more detailed information on the Imposition main window and its
components, see Chapters 5 and 6.

Printing books with the Imposition feature of
DocBuilder Pro

This section describes the process of transforming an application-specific file into a
bound book. Concepts and terminology are introduced to help you take advantage of
all the features of DocBuilder Pro.

Printers and copiers that image documents on standard Letter- or Legal-sized paper at
high speeds are common in office environments. Although the image quality and
output efficiency of such devices is adequate for correspondence and office memos,
they cannot image jobs with complex document layouts, or those that require higher
resolution or a large number of copies.

Until recently, the only way around these limitations was to use traditional printing
systems to impose your document—that is, to arrange its pages in the correct order
and orientation for printing and a variety of binding styles. You might have used a
service bureau to access high-volume, high-resolution printers. However, DocBuilder
Pro, teamed with digital copiers, now makes it cost-effective to produce short-run,
fully-imposed (also called “ganged-up”) documents.

Basics of imposition layout

Commercial offset printers and web presses use wide rolls of paper and large printing
plates capable of imaging numerous pages on a single sheet. For example, it is common
for such printers to image up to 32 full-size pages on a single press sheet, a process
inherently faster than printing a single page at a time. DocBuilder Pro allows you to
image multiple pages on a single sheet, but the output devices it supports are digital
copiers, rather than traditional printing presses. In this manual, the paper on which a
job is imaged is referred to as the sheet.
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The printed sheet is folded into something resembling a booklet with connected pages.
The folded sheet, called a signature, is then trimmed to the finished size.

For pages to appear in normal reading order and position in the final booklet, their
ordering and positioning on the sheet must differ from the normal book-reading order.
You can demonstrate this for yourself using an ordinary sheet of paper.

To MODEL AN EIGHT-PAGE BOOKLET

1.

Fold the paper in half horizontally.

Fold the top edge of the sheet down to meet the bottom edge.

,,,,,,,,,,,,,,,

Fold the paper again vertically.

Fold the left edge of the sheet over to the right edge. Now you have a miniature version
of a signature.
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3. Position the signature with the vertically folded edge to the left and the horizontally
folded edges across the top.

The paper should now resemble a small eight-page booklet (with the tops of pages
joined at the fold).

4. Page through the booklet as if you were reading it, and number each page
sequentially.

Number the front and back of each page—in general, books have content on both
sides of each page. The front cover of the booklet should be page 1 and the back cover
of the booklet should be page 8. You can also underline each number to highlight the
page orientation.

Note: Printing on both sides of the sheet is called duplex printing; printing on only
one side of the sheet is called simplex printing. Not all copiers support duplex printing;
and of those that do, variations in implementation exist. DocBuilder Pro supports
duplex printing that corresponds to the print options of the output device.

When you unfold the signature, the page numbering should look something like the
following illustration.

L8 L\ ¢

A\ 9 S\ 3

Front Back
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Notice that:
* The folds subdivide the sheet into areas representing pages in the final booklet.
* Page numbers do not appear in book-reading order.

* Some page numbers are upside down.

Some pages must be printed upside down on the sheet in order for them to appear
right-side up in the final booklet, and pages must also be printed out of numerical
sequence on the sheet in order for them to appear in numerical sequence in the final

booklet.

This process of folding paper and numbering pages to approximate the finished piece
is called making a folding model, and it is a common first step in planning a print job.
The folding model provides valuable information about page placement, which you
can use to create a plan, or sketch, of how pages are placed on the sheet. This plan is
called a layout.

DocBuilder Pro frees you from the tedious and error-prone process of creating accurate
physical models of the imposed book in order to lay out pages. With DocBuilder Pro,
you open the source file to be imposed and specify how many rows and columns of
pages to image on a sheet. DocBuilder Pro simplifies this process even further by
providing predefined layouts for common impositions such as booklets and brochures.
You can also save your own custom layouts for easy reuse.

Printer’'s marks

In addition to specifying the placement of pages on a sheet, the layout also specifies
how the finished sheet will be cut and folded. For example, the layout specifies whether
the large finished sheet is folded and cut to create a booklet, or simply folded (and not
cut) like a map.



A-5 | Basics of Imposition

A DocBuilder Pro layout designates the location of folds, cuts, and other elements by
means of markings called printer’s marks, which appear on the printed sheet outside
the main content area of the job.

* The job label comprises descriptive text such as the name of the job, a sheet
identifier, and the date and time the sheet was printed.

¢ The location of a fold is defined by a dotted line called a fold mark; similarly, the
location of a cut is defined by a solid line called a trim mark.

* Specialized marks also define the size and locations of margins (space surrounding
the page’s content area), gutters (space between pages), and bleeds (extensions of
content beyond a trim mark; used to ensure that the printed area extends to the very
edge of a trimmed page).

DocBuilder Pro makes it easy to set up gutters and specify a set of printer’s marks to
image on the finished sheet, as shown in the following illustration.

Thursday, August 14, 2003, 14:00:01 PM
\

Job label

Trim marks ‘

Fold mark

Gutter

Margin
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Additional sheets

A book layout must also adjust the placement of pages according to the total number
of pages in the job. For example, a book is often composed of more pages than can be
printed on a single sheet. When the number of pages in the book is a multiple of the

number of pages on a sheet, the same layout plan is used to place pages on additional
sheets, until all of the pages in the book are printed. However, if the total page count is
not an even multiple of the number of pages in the layout, one signature may be laid

out to accommodate the discrepancy.

For example, if your layout places 8 pages on a sheet and the total page count in the
book is 12, one of its signatures holds only 4 content pages, with the rest of the space
on the sheet blank. If you do not want blank pages in the middle of the finished book,
insert blank pages intentionally, for example after the cover page, after the table of
contents, or between chapters. To insert blank pages, open the job in the Thumbnail A
window, right-click the page you want to add the blank to (or pull down the Page
menu), and select Insert blank page.

DocBuilder Pro allows you to add blank pages or add, delete, and rearrange pages from
multiple source documents easily, so you can quickly preview the results of page
manipulations.
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Binding methods

A book layout also specifies the means by which sheets are gathered and bound.
Stitching or stapling finished pages across a common center fold, or spine, is called
saddle stitch binding, and the stitched pages are called a saddle. Multiple folded sheets
can be stitched into the same saddle as a group. Stacking signatures, grinding the
spines off, and then gluing them together is called perfect binding. You can combine
saddle stitch and perfect binding methods by stacking two or more groups one on top
of another on a common fold line and gluing them together; this is called a nested

saddle.

Saddle Perfect Nested Saddle

The binding method you use affects the order in which pages are placed on the sheet;
for example, the page ordering used to perfect bind a book must be different from that
used to saddle stitch the same job. Thus, your layout must specify the method by
which the finished job will be bound.

The choice of a binding method is determined by the job’s size, complexity, and
budget. Saddle stitch binding is very cost-efficient, but is more suitable for small
booklets than for large jobs. (A rule of thumb is that saddle stitch binding works best
for booklets or brochures with a maximum of 88 pages.) Conversely, perfect binding is
more expensive but more suitable for larger jobs.
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DocBuilder Pro reorders imposed pages automatically according to your choice of
binding method, which can save a significant amount of time and effort. Consider, for
example, what must be done when a book that was to be saddle stitched exceeds the
bindery’s maximum page count and must be reimposed as a perfect-bound book. To
redo the imposition by traditional means would be labor-intensive; with DocBuilder
Pro, it takes only moments.

Shingling and creep

All books and brochures use a sheet that is folded to create separate page areas. Because
the sheet itself has some thickness, each fold causes a very small incremental shift in the
location of the edge of each page relative to the others. The result is that the edges of
pages furthest from the saddle’s innermost fold seem to move away from the edges of
pages closest to the innermost fold. As the number of pages in the saddle increases, so
does the amount of this shift, which is known as shingling. To counteract the effects of
shingling (illustrated in an exaggerated manner in the following figure), the bindery
trims the edges of the finished book to a common edge.

Shingling

Trimming the bound pages resolves only half of the problem, however—as the edges of
pages move, so do the content areas imaged on them. The apparent shift of content
area caused by folding a sheet multiple times is known as creep or binder’s creep. The
effect of creep is that the content area of pages closer to the innermost fold in a saddle
appear to move towards the outer margins of the page.
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Creep becomes more noticeable as the number of groups in a saddle increases, and its
effect is most noticeable on pages farthest from the center fold of the saddle.
Consequently, a book layout must also specify the number of groups in each saddle
because the number of groups in each saddle affects the amount of creep that needs to

be accounted for.

Creep

DocBuilder Pro compensates for creep automatically when you change any aspect of
the imposed job that is affected by creep.

Gang-Up printing

Layout is essential for defining the elements of complex print jobs, such as booklets
and books, but it can also be useful for smaller jobs. Consider, for example, how you
might approach the task of printing business cards. It is slow, wasteful, and expensive
to print a single business card per sheet, when you can repeat the image of the business
card until the entire sheet is filled. This printing technique is known as Gang Up
Repeat because the image is repeated in each page area, or step, on the sheet. After
printing, the sheet is cut apart to produce individual cards.

Gang Up Repeat layout
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This job can be made even more efficient by eliminating the gutters between cards,
allowing you to reduce significantly the number of cuts required to separate each card
from its neighbor. Defining zero-width gutters on a shared cut line in this manner is
called using a common blade for those cuts.

If you need to print business cards for several different clients, you could perform

a Gang Up Repeat printing job for each, but you might still wind up wasting

paper and time if the jobs do not fit easily into a simple multiple of sheets. A more
efficient approach is to print several jobs on a single sheet, and then print that sheet
as many times as required. The technique of printing multiple jobs on the same sheet
is known as Gang Up Unique. DocBuilder Pro provides both Gang Up Repeat and
Gang Up Unique.

F The Marble Group F The Marbte Group

Gang Up Unique layout
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Appendix B: This appendix gives descriptions of the built-in templates provided with DocBuilder
Pro.
Templates

1-Up Full Bleed
The 1-Up Full Bleed layout is used to print one page per sheet. The printer’s marks

indicate where to cut the paper so that the content extends to the edge of the paper.
The following settings are applied for this layout:

* Bleeds

e Printer’s Marks (trim marks and job label only)

e Scale to Fit

Gang Up Unique

ithmetic. pdf

Builder

Layout

Seale
Finishing Suface 10f30 | Fit Page 4| 1L}

NoTe: There are no page number restrictions for the 1-Up Full Bleed layout.
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2-Up Perfect

The 2-Up Perfect layout is used to create signatures for a perfect bound book. Each
sheet is folded once and stacked on top of one another. For more information on
binding methods, see page A-7.

The following settings are applied for this layout:

* Duplex

¢ Bleeds

* Printer’s Marks (fold marks, trim marks, and job label)

Scale to Fit

Binding Perfect

Asithmetic. pdf

Builder

Firishing Sutsce2oi16 | FiPage « l
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The 2-Up Perfect layout should be used with jobs that have multiples of four pages,
but it can be used with jobs that have any number of pages. Additional blank pages are
added if necessary. Pages are ordered in groups of four so that, when folded, each sheet
has four sequential pages. For example:

* 4 pages
4 1 2 3
Sheet 1, Sheet 1,
front side back side
* 8 pages
4 1 2 3 8 5 6 7
Sheet 1, Sheet 1, Sheet 2, Sheet 2,
front side back side front side back side

Note: The Creep Adjustment option has no effect on this template.
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2-Up Saddle
The 2-Up Saddle layout is used to create sheets for a saddle bound book. All of the

sheets are folded together, one inside the other. For more information on binding
methods, see page A-7.

The following settings are applied for this layout:

¢ Duplex

* Bleeds

* Printer’s Marks (fold marks, trim marks, and job label)

¢ Scale to Fit
* Binding Saddle

Asithmetic. pdf

Builder

Firishing Sutsce2oi16 | FiPage « l
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The 2-Up Saddle layout should be used with jobs that have multiples of four pages,
but it can be used with jobs that have any number of pages. Additional blank pages are
added if necessary. Pages are ordered so that, when sheets are folded and stitched
together, the pages are sequential. For example:

* 4 pages
4 1 2 3
Sheet 1, Sheet 1,
front side back side
* 8 pages
8 1 2 7 6 3 4 5
Sheet 1, Sheet 1, Sheet 2, Sheet 2,

front side back side front side back side
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3-Up Trifold Brochure

The 3-Up Trifold Brochure layout consists of a single sheet folded into three sections.
Although the three sections are the same width, the space between each section varies
so that the leftmost panel can be folded over the other two panels.

The following settings are applied for this layout:
* Duplex

* Printer’s Marks (fold marks, trim marks and job label only)
Scale to Fit

Gang Up Unique

Builder

Layout

Scale

Finishing Sufsce2of2_ |  FiPage « 1+]
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The 3-Up Trifold Brochure layout can be used only with jobs that have six pages. If the
job contains more or less than six pages, an error message appears. The pages are

ordered as follows:

3 6 1 2 4 5
Sheet 1, Sheet 1,
front side back side

The 3-Up Trifold Brochure is usually folded as shown in the following illustration.
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4-Up Gate Fold

The 4-Up Gate Fold layout is used most often in the case of a four-panel brochure.
The finished brochure unfolds to double, then four times the original size.

The following settings are applied for this layout:
* Duplex

e Printer’s Marks (fold marks, trim marks and job label only)
* Scale to Fit

Gang Up Unique

~ Asithmetic. pdf

Builder

Layout

Seale
Firishing Sufacelofz | FitPage  [d] | |




B-9 | Templates

The 4-Up Gate Fold layout can be used only with jobs that have eight pages. If the job
contains more or less than eight pages, an error message appears. The pages are ordered

as follows:

3 8 1 2 4 5 6 7
Sheet 1, Sheet 1,
front side back side

The 4-Up Gate Fold is usually folded as shown in the following illustration.
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4-Up Head to Head

The 4-Up Head to Head layout is used to create booklets from a layout of four pages
on each side of the printed sheet. By rotating the two topmost pages, the signature can
be folded both horizontally and vertically, and trimmed. The finished booklet has all

pages in the correct order and rotation.

The following settings are applied for this layout:

* Duplex

¢ Bleeds

* Printer’s Marks (fold marks, trim marks, and job label)
Scale to Fit

Binding Saddle

Builder

Firishing Swlace1oi2 | FiPage g I




B-11 | Templates

The 4-Up Head to Head layout should be used with jobs that have multiples of eight
pages, but it can be used with jobs that have any number of pages. Additional blank
pages are added if necessary. Pages are ordered so that, when sheets are folded with two
folds at 90 degrees, trimmed, and stitched together into signatures, the pages are
sequential. Note that although this layout requires two folds, the template applies a
fold mark on the spine fold only. For example:

¢ 8 pages
9 14 ¢ 9
8 1 2 7
Sheet 1, Sheet 1,
front side back side
* 16 pages
6 8 L | o1 | 9 ¢ |al
16 1 2 15 14 3 4 13
Sheet 1, Sheet 1, Sheet 2, Sheet 2,
front side back side front side back side

The 4-Up Head to Head is usually folded as shown in the following illustration.
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4-Up Z-Fold

The 4-Up Z-Fold layout allows many panels to be folded on top of one another
without stressing the folded spine. The most common example is a road map.

The following settings are applied for this layout:
* Duplex

e Printer’s Marks (fold marks, trim marks and job label only)
* Scale to Fit

Gang Up Unique

ithmetic. pdf

Builder

Layout

Seale
Firishing Sufacelofz | FitPage  [d] | |
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The 4-Up Z-Fold layout is used only for jobs that have eight pages. If the job contains
more or less than eight pages, an error message appears. The pages are ordered as

follows:

2 3 4 5 6 7 8 1
Sheet 1, Sheet 1,
front side back side

The 4-Up Z-Fold is usually folded as shown in the following illustration.
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This appendix describes error messages you might see, and provides some
troubleshooting guidelines should a problem arise with the Fiery EX2101, Command
WorkStation LE, or Command WorkStation. If you are unable to resolve a problem

after referring to this chapter, contact your authorized service/support center.

Error messages

Error messages can result from problems with the job, the Fiery EX2101, Command
WorkStation, Command WorkStation LE, Fiery WebSpooler, Fiery Spooler, or the
copier. When an error interferes with printing, you see a message in the Activity
Monitor of Command WorkStation or Command WorkStation LE. The status bar
that displays the message indicates the process in which the error occurred.

An error message for the Fiery EX2101 sometimes remains displayed on Command
WorkStation or Command WorkStation LE even after you resolve the error. There
might be a brief delay while the Fiery EX2101 communicates the resolution of the
error to the application. After a short delay, printing resumes and the Command
WorkStation or Command WorkStation LE window is updated.

If you encounter a Fiery EX2101 message alerting you to check the power and cable,
there may be a problem with the copier power or cable connection. Check to make
sure the copier is turned on. Make sure the cable connection between the

Fiery EX2101 and the copier has not come loose. When the cable is securely connected
to both the Fiery EX2101 and the copier, the Fiery EX2101 resumes printing.

For information on resolving copier-related errors, refer to your copier documentation.
You can cancel the pending print job while you attend to a given error condition.
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Troubleshooting

Before you call for service, follow the suggestions in this section. If you cannot resolve
the problem, make a note of the error condition and contact your authorized service/
support center.

Command WorkStation or Command WorkStation LE does
not respond

If the Command WorkStation or Command WorkStation LE windows do not update,
log off and then quit Command WorkStation or Command WorkStation LE. Restart
Command WorkStation or Command WorkStation LE, or restart the computer. To
force an exit from Command WorkStation, press Ctrl-Alt-Delete, and use the Task
Manager to close Command WorkStation.

If the Command WorkStation or Command WorkStation LE windows do not update,
or no jobs are displayed, and the mouse has no effect (you cannot select a job or a
window, use a right mouse command, or choose a menu item), the Fiery EX2101 is
down or network communication has failed.

At the Fiery EX2101, disconnect and reconnect the network cable, and try printing a
Test Page or Configuration page. If that fails, restart the server.

If the Fiery EX2101 Control Panel does not respond to the Menu button, turn off and
on the Fiery EX2101. When the Fiery EX2101 reaches Idle, restart your job
management application.
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Unexpected printing results

If this happens

This is the problem

The job settings are not
carried out as you expected.

If the user printed from Apple Mac OS, there may be two
conflicting print settings. You can check the job properties by
double-clicking the job. For a table of job properties and
conflicting properties, see the Printing Guide. Notify users of
these conflicts so they can avoid them in the future.

If you expected the settings you see in the Properties window,
be aware that the Copies field does not currently reflect user
settings, and that Page Range and Scale percent are All and
100%, respectively, unless they were changed after being sent
for printing.

The job does not print.

Some printing errors may be displayed in the Print status bar.
When the job is in the Printed queue, jobs that had a
PostScript error are displayed in a light red job row.
Double-click anywhere in the row to see the error message.

There are font errors.

If user-specified fonts that are not resident on the

Fiery EX2101 are not printing correctly in PostScript files
that are downloaded by users, request that they embed the
fonts in the PostScript file or print directly from their
application. If special fonts are not downloaded automatically
when users print from applications, the fonts should be
downloaded directly to the Fiery EX2101 with Fiery
Downloader. This can be done by the user or the operator,
provided the Direct connection is enabled. For information
about Fiery Downloader, see the Printing Guide.
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Clearing the server

Clearing the server is an Administrator option that can be used as a last resort if a job
persists in the system and prevents printing despite attempts to cancel or delete it. If all
other troubleshooting methods have failed, clear the server.

You can clear the server from the Control Panel (see the Configuration Guide) or by
using the Server> Clear Server command in Command WorkStation or Command
WorkStation LE.

Users cannot connect to the Fiery EX2101

If users cannot connect to the Fiery EX2101, or cannot find the Fiery EX2101 from
their workstations, the network administrator may need to troubleshoot their network
connections, and check settings on the servers they use for printing. If settings have
changed, it may be necessary to reconfigure the Fiery EX2101.

For example, if print servers or print queues on a Novell server are renamed or deleted,
or if accounts or permissions are changed, the Fiery EX2101 administrator may have
to edit settings or enter new settings in IPX (Novell) Setup to reflect the new
configuration.

If users cannot connect to the Fiery EX2101 with Fiery Downloader from a Windows
client computer, you may need to reconfigure the utility’s connection to the server. For
details, see the User Software Installation Guide.

Mac OS users may be unable to connect to the Fiery EX2101 if a network
administrator has assigned it to a different zone or added zones where previously there
were none.
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If you have configured the Fiery EX2101 and set up client computers and network
servers according to guidelines in the Configuration Guide and the User Software
Installation Guide, try printing a Test Page (in Command WorkStation or Command

WorkStation LE, choose Print Pages from the Server menu).

If you can print the Test Page but still cannot print a document from a remote

computer, contact the system administrator to troubleshoot the network connection.

If you cannot connect, and you cannot print the Test Page, check the copier’s touch

panel display.

If this happens

Try this

The copier is not in

Standby mode.

The copier’s Automatic Power-Off function may have shut
down the copier.

Turn the copier on, and try printing a Test Page again when
the copier has warmed up.

You still cannot print a
Test Page.

Make a copy. If you can make a copy, restart the

Fiery EX2101, and when you see Idle on the status line of the
Fiery EX2101 display, try printing a Test Page again. If the
Test Page still fails to print, contact your authorized service/
support center.

Setup error messages

For information on Setup error messages, see the Configuration Guide.
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viewing entire 5-9 target file 7-14
sheet information 6-8 template
Sheet settings 6-4 applying 5-11
Creep Adjustment 6-5 defined 5-11
Orientation 6-5 deleting 6-25
Size 6-4 limitations 6-24
sheet size, setting 6-4 saving 6-25
shingling A-8 saving imposition settings 6-25
Show Animations preference 2-29 selecting 5-11
Show Import Options Dialog Template menu 5-11
preference 2-29 temporary files 6-26
signature A-2 temporary folder, for job files 2-28
simplex printing A-3 Temporary path preference 2-28
slot 6-11 Test Page 2-26
sorting jobs 3-7 printing C-5
source file 7-14 problem printing C-5
spine A-7 Thumbnail A
Spool area 7-8 command 7-6
spooled jobs Delete command 7-15
displayed in Fiery WebSpooler 7-4 Duplicate command 7-15
icons 7-8 editing options 7-15
spooling page commands 7-14
defined xv page display 7-11
in job flow 1-3 window 7-14
starting the server 8-4 Thumbnail B 7-14
status bars command 7-6
Print 7-3 time 6-8
RIP 7-3 Tray Alignment command 2-29
Spool 7-3 Trim Marks 6-8, A-5

status indicators, defined 2-10
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troubleshooting
Command WorkStation hangs C-2
Command WorkStation LE hangs C-2
general guidelines C-2
slow redraw 5-7
unexpected printing results C-3
users cannot connect to the printer C-4

U

Undo command 4-5, 7-15

undo, in editing thumbnail views 4-9, 7-16
Units preference 2-28

units, setting 2-28

Use Master option 3-27, 3-29

v
variable data printing 3-27
View menu 5-7, 5-8
view modes
compared 5-8
layout 5-7
preview 5-7
view only (Guest) access 3-5

w
WebSpooler WebTool, see Fiery WebSpooler
Windows NT

logon 8-4, 8-5

Z
Zoom tool 5-8,5-9






	Introduction
	About this manual
	Terminology

	Chapter 1: About Job Management
	Job environments
	Levels of job control
	Setting up an operator-controlled environment

	Understanding job flow
	Spooling, processing, and printing
	Visualizing job flow

	Communicating with users
	What the operator should check

	Overview of the job management utilities
	Command WorkStation
	Command WorkStation LE
	Fiery WebSpooler and Fiery Spooler


	Chapter 2: Introduction to Command WorkStation and Command WorkStation LE
	The graphical interface
	Active Jobs window
	Jobs window
	Activity Monitor
	Job status indicators
	Action buttons
	Preview windows

	Monitoring single or multiple Fiery�EX2101 servers*
	Customizing the graphical interface
	Using layout styles*
	Showing, hiding, and arranging components

	Using commands
	Menu bar
	Context-sensitive menus

	Preparing to work with Command WorkStation or Command WorkStation LE
	Connecting to the Fiery�EX2101
	Printing Fiery�EX2101 information pages
	Setting preferences
	Correcting tray alignment*
	Managing Fiery�EX2101 fonts


	Chapter 3: Using Command WorkStation or Command WorkStation LE
	Starting up and logging in
	Logging in to the Fiery�EX2101
	Access levels
	Logging out
	Removing the Fiery�EX2101 from the server list

	Monitoring jobs
	Selecting jobs
	Sorting job displays
	Customizing job ticket information

	Managing job flow
	Importing jobs
	Using job management commands
	Viewing and overriding print settings
	Reordering jobs*
	Managing jobs on multiple Fiery�EX2101 servers*
	Canceling jobs

	Defining Mixed Media settings*
	Inserting tab media*
	Printing FreeForm variable data documents
	Creating and monitoring FreeForm masters
	Using FreeForm masters with variable data jobs
	Tips for using FreeForm

	Archiving jobs
	Using the Job Log
	Searching for jobs

	Chapter 4: Previewing and Manipulating Jobs
	Previewing jobs
	Displaying thumbnail previews
	Preview window controls
	Displaying full�screen previews

	Editing and merging jobs
	Editing jobs
	Merging jobs


	Chapter 5: Using DocBuilder Pro
	Previewing, editing, and merging jobs
	Imposition window
	Job previews
	Navigating in the Imposition window
	Switching between page view and layout view
	Setting magnification levels
	Viewing the sheets

	Using templates
	Saving your work

	Chapter 6: Advanced Features of DocBuilder Pro
	Mixed Page mode and Fixed Page mode
	Imposition settings
	Sheet settings
	Layout settings
	Scale settings
	Finishing settings

	Modifying the layout manually
	Reordering pages in Layout mode
	Adding, duplicating, and deleting sheets
	Editing page content
	Rotating pages
	Setting gutter sizes

	Managing templates
	Tips for using the Imposition feature of DocBuilder Pro
	Page-level operations
	Saving imposed jobs


	Chapter 7: Fiery WebSpooler and Fiery Spooler
	Tracking and managing jobs with Fiery WebSpooler
	About the Fiery WebSpooler window
	Manipulating job options and job flow
	Overriding job option settings

	Job icons
	Spool area
	RIP area
	Print area

	Previewing, editing, and merging jobs
	Previewing raster jobs
	Displaying full�screen previews
	Editing and merging raster files
	Using the Job Log

	Fiery Spooler for Mac OS computers
	Starting Fiery Spooler
	Connecting to a different Fiery�EX2101 from Fiery Spooler


	Chapter 8: Using FieryBar
	Introduction to FieryBar
	Status
	Activity light
	Commands

	Starting and shutting down the Fiery�EX2101
	Restarting the Fiery�EX2101
	Shutting down the Fiery�EX2101


	Appendix A: Basics of Imposition
	Printing books with the Imposition feature of DocBuilder Pro
	Basics of imposition layout
	Printer’s marks
	Additional sheets
	Binding methods
	Gang-Up printing


	Appendix B: Templates
	1-Up Full Bleed
	2-Up Perfect
	2-Up Saddle
	3-Up Trifold Brochure
	4-Up Gate Fold
	4-Up Head to Head
	4-Up Z-Fold

	Appendix C: Troubleshooting
	Error messages
	Troubleshooting
	Command WorkStation or Command WorkStation LE does not�respond
	Unexpected printing results
	Clearing the server
	Users cannot connect to the Fiery�EX2101
	Setup error messages


	Index

